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Development Kit EFM32-G2XX-DK

Feature rich development platform for evaluation, prototyping and application
development for the EFM32 Gecko MCU family with the ARMCortex-M3 CPU core.

Main features;

* Advanced Energy Monitoring provides real-time visibility into the energy
consumption of an application or prototype design.

* Exchangeable prototyping board for custom application development

* On-board emulator with debug out functionality
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1 Introduction

1.1 Features

» Advanced Energy Monitoring system for precise current tracking.

» Special hardware configuration for isolation of the MCU power domain.
» Replaceable prototyping board for quick custom application development.
* Full feature USB debugger / emulator with debug out functionality.

e 3.5-inch TFT-LCD 320x240 pixel RGB color display.

» Board Controller for board configuration / signal routing.

» Single ended and differential ADC inputs.

 Line-in stereo audio input amplifier.

» Line-out stereo audio output amplifier.

* 2 RS232 connectors.

» 3-axis accelerometer.

« SPI Flash and microSD card reader (SPI mode).

« EEPROM.

» Temperature sensor.

* IrDA tranceiver.

» 256Kx16bit / 512KB parallel bus SRAM.

e 2Mx16 / 4MB parallel bus NOR Flash.

* Ambient light sensor and potmeter.

* 5 way joystick.

4 User buttons, 8-bit DIP switch and 16 user LEDs.

1.2 Board Configuration

The EFM32-G2XX-DK is a highly flexible development kit. It offers many features and peripherals to the
EFM32 through jumperless configuration. The different features on the kit are available as configured
in the motherboard's Board Controller. Configuration is easily done by a simple API in the kit Board
Support Package.

If none of the motherboard features are needed, configuration of the Board Controller is not necessary.
All EFM32 GPIO pins are available on the prototyping board.
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2 Kit Block Diagram

An overview of the Kit is shown in the block diagram below.

Figure 2.1. EFM32-G2XX-DK Block Diagram
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3 Mainboard hardware layout

The layout of the EFM32-G2XX-DK mainboard is shown below.

Figure 3.1. EFM32-G2XX-DK hardware layout
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4 Power supply
4.1 USB

The EFM32-G2XX-DK can get it's power from the standard USB 2.0 Type B port located on the
motherboard. The USB hub the kit is connected to needs to be able to deliver 500 mA (5 unit loads).

4.2 External power supply

By using the DC jack plug located on the motherboard, the EFM32-G2XX-DK can be powered by an
external power supply. The voltage must be 5V and the supply must be able to deliver 500mA.

The power jack dimensions should be a standard 5.5 mm outer diameter and 2.1 mm inner diameter.
The tip is 5V and the sleeve is GND.
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5 Reset infrastructure
5.1 MCU

The primary user reset for the MCU is the reset button on the MCU board. This will only reset the MCU.
It can also be reset using the board controller, by writing to the RESET_MCU bit in the RESET register.
Finally, it can be reset by debuggers.

5.2 Board controller

The board controller can be reset by pushing the reset button on the main board.
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6 Peripherals

The development kit has a rich set of user programmable peripherals that allows most of the EFM32G
on-chip peripherals to be evaluated and tested.

The registers referred to in this chapter are accessible using the kit Board Support Package. Refer to
the BSP chapter in this manual to learn how to enable the motherboard peripherals. A reference to all
the registers and their function is in the Board Controller chapter.

6.1 Pushbuttons

The state of the pushbuttons marked SW1 to SW4 can be read from the board controller, using the
PUSHBUTTON register. The buttons are debounced by RC filters with a time constant of 1ms.

6.2 DIP switches

The dipswitch positions can be read from the board controller, using the DIPSWITCH register. The
switches are not debounced.

6.3 Joystick

The joystick position can be read from the board controller, using the JOYSTICK register. The positions
are debounced by RC filters with a time constant of 1ms.

6.4 LEDs

The user LEDs can be set by the board controller by writing to the LED register. The state of the LEDs
can also be read back.

6.5 Differential analog input

This BNC input signal is converted to a differential signal by a differential operational amplifier using
ground as reference.The op amp output common mode voltage is 1.65V, and also implements a low-
pass active filter with a 3dB cutoff frequency of 4AMHz.

The common mode voltage can be changed by adjusting the R5 and R12 resistors. It can also be
controlled by the VCM pin on the EFM if a shunt resistor is soldered in place of R252 and R5 and R12
are removed.

The peripheral is connected directly to the EFM when the ANALOG_DIFF bit in the PERCTRL register
in the board controller has been set.

6.6 Single ended analog inputs

This peripheral connects the two BNCs to the ADC on the EFM, and can be used as a single ended
analog interface. It can also be used for digital 1/O.

The peripheral is connected directly to the EFM when the ANALOG_SE bit in the PERCTRL register in
the board controller has been set.

6.7 Line in / Audio in

This is an audio input amplifier with filter, and the output connects to the ADC of the EFM. The gain
of the amplifier is 0 dB and the bias point is 1.65 V. The filter is a 3-pole linear phase MFB filter with
a cutoff frequency of 20 kHz. In addition to the input amplifier and filter, the line in is equipped with a
voltage divider resulting in 6dB attenuation.
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The peripheral is connected directly to the EFM when the AUDIO_IN bit in the PERCTRL register in the
board controller has been set.

6.8 Line Out / Audio out

This is an audio output amplifier with filter, and the input connects to the DAC of the EFM. The gain of
the amplifier is 6 dB and is referenced to ground. The filter is a 3-pole linear phase MFB filter with a
cutoff frequency (at -3 dB) is at 27 kHz.

The peripheral is connected directly to the EFM when the AUDIO_OUT bit in the PERCTRL register in
the board controller has been set.

6.9 RS232

There are two RS232 connectors on the board which connects to the USART and LEUART of the EFM.
The RS232 driver runs at 3.3 V and itis recommended that the MCU voltage is 3.3 V as well. Unpredicted
behavior can occur if the MCU voltage is much lower than 3.3V and the RS232 driver is enabled.

The two RS232 drivers can be connected to the EFM individually by setting the RS232_A and RS232_B
bits in the PERCTRL register in the board controller. The RS232_SHUTDOWN bit must also be cleared.

Note
When none of the RS232 drivers are in use, it is highly recommended that the driver is shut
down by setting the RS232_SHUTDOWN bit in the PERCTRL register.

6.10 Accelerometer

This is a 3-axis accelerometer that connects to the ADC of the EFM. It outputs voltages proportional
to the g-forces for each axis. There are two settings for the range. If ACCEL_GSEL in the PERCTRL
register is cleared, the range is from 0 to 1.5 g, and when the bit is set the range is from 0 to 6 g.

The peripheral is connected directly to the EFM when the ACCEL bit in the PERCTRL register in the
board controller has been set.

6.11 IrDA

This is a 115.2 kBit/s (SIR) IrDA transceiver with a range of up to 70 cm, and connects to the USART
of the EFM.

The peripheral is connected directly to the EFM when the IRDA bit in the PERCTRL register in the board
controller has been set.

6.12 Potmeter

This is a potmeter pulled to 3.3 V by a 10k resistor, and it is connected to the ADC of the EFM. Using
the potmeter the output of this peripheral can be adjusted from 0V to 3 V.

The peripheral is connected directly to the EFM when the POTMETER bit in the PERCTRL register in
the board controller has been set.

6.13 Ambient light sensor

This is an LDR in series with a 10k resistor, and it is connected to the ADC of the EFM. The output
voltage of the sensor ranges from 0.1 V to 2 V, increasing with the amount of light.

The peripheral is connected directly to the EFM when the AMBIENT bit in the PERCTRL register in the
board controller has been set.
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6.14 1°C EEPROM

The 2 KB 1°C EEPROM is connected to the 1°C module of the EFM. The maximum bus speed is 400
kHz and the address is 0xAO.

The peripheral is connected directly to the EFM when the 12C bit in the PERCTRL register in the board
controller has been set.

6.15 I°C Tem perature sensor

The I°C temperature sensor is connected to the I°C module of the EFM. Temperature range of the sensor
is -55 °C to +125 °C. The maximum bus speed is 400 kHz and the address is 0x90.

The peripheral is connected directly to the EFM when the 12C bit in the PERCTRL register in the board
controller has been set.

6.16 SPI Flash

A 16 MBIt SPI flash is connected to the SPI module of the EFM.

The peripheral is connected directly to the EFM when the SPI bit in the PERCTRL register in the board
controller has been set. To route the chip select correctly, the FLASH bit in the BC_SPI_CFG register
in the board controller must also be set.

6.17 microSD

A microSD slot is connected to the SPI module of the EFM.

The peripheral is connected directly to the EFM when the SPI bit in the PERCTRL register in the board
controller has been set. To route the chip select correctly, the MICROSD bit in the BC_SPI_CFG register
in the board controller must also be set.

6.18 TFT LCD

The TFT LCD can be accessed from the EFM through the board controller. The interface can be
configured to be either 9 bit or 16 bit. This selection is done by setting the 16BIT bitin the DISPLAY_CTRL
register in the board controller. It is also possible to use the SPI interface, but then the R112 resistor
must be moved over to the position of R112.

Note
16 bit or SPI interface options are currently not supported by the board controller.

6.19 SRAM

The 512 KB SRAM can be accessed from the EFM through the board controller. The data width is either
8 or 16 bit, depending on the access method.

6.20 NOR Flash

The 4 MB NOR Flash can be accessed from the EFM through the board controller. The data width is
either 8 or 16 bit, depending on the access method.
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7 Board Support Package

The Board Support Package (BSP) is a set of C source and header files that enables easy access to,
and control over board specific features and peripherals.

The package defines an API for direct access to the board controller registers, as well as regular function
calls for the most frequently used features.

7.1 Installation location

When installing the complete software package for the kit, the BSP will be installed under the main
installation directory, typically in a location such as

C.\Program Fi | es\ Energy M cro\ boar ds\ EFM32_Gxxx_DK\ bsp\

or something similar. All files in the board support package is prefixed by dvk.

7.2 Resource usage

The BSP can be configured to use 1 of 2 access methods

* SPI - USART?2 Serial Peripheral Interface
» EBI - External Bus Interface

SPI1 and EBI have different requirements regarding pin usage, see table below:

Table 7.1. GPIO Usage

GPIO Port SPI Pins EBI Pins
A 0-6, 15
B

C 2-5,13 12

D

E 8-15

F 2-5

The advantage of EBI over SPI, is that EBI access is a fast, directly memory mapped register access,
while SPI will add a synchronous two way transfer over a slower SPI interface. The disadvantage of EBI
is that it will consume a lot more 1/O pins than SPI. The DVK will by default be configured to use SPI,
to enable EBI a small SPI initialization routine needs to be called once (per restart of the entire kit, not
per restart of the EFM32).

For DK part number EFM32_G8xx_DK with LCD controller, SPI is the only option as EBI and LCD cannot
be combined.

You must take care in not using these pins for other purposes after initialization of the BSP, as conflicts

and unpredictable behavior will result. You can disable the DVK interfaces after you have set your
configuration.

7.3 Application Programming Interface

To use the BSP, include the Development Kit header file, like this:
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#i ncl ude "dvk. h"

Depending on the part number defined in your project as a build option, the DVK will default to the most
common access method for your MCU module according to part number. If you need to override the
default board control access method, you can define the access method by overriding the default with
DVK_SPI_CONTROL or DVK_EBI_CONTROL defines, such as

#defi ne DVK_SPI _CONTRCL
#i ncl ude "dvk. h"

All functions in the BSP are prefixed with DVK_. The main initialization routine is defined as
voi d DVK_ i nit(void);
and must be called before any access to the DVK-functions. To disable the BSP, call

voi d DVK _di sabl e(voi d);

You can access all registers with the generic functions

void DVK witeRegister(volatile uintl6_t *addr, uintl6_t data);
uint16_t DVK readRegi ster(volatile uintl6_t *addr);

Usable addresses for these functions, including bit fields are defined in the header file
dvk_bcregisters. h
The functions

voi d DVK_enabl ePeri pheral ( DVKPeri pheral peri );
voi d DVK_di sabl ePeri pheral ( DVKPeri pheral peri );

can be used to toggle access/peripheral switches to all peripherals on the DVK. See the "peripheral”
example application for usage.

In addition to these main functions, full documentation of the complete API is included in the Doxygen/
HTML documentation of the installed package.

7.4 Example Applications

There are a number of example applications to illustrate the usage of the DVK API. You will find these
with their corresponding IAR Embedded Workbench and Keil MDK-ARM project files under

C:\ Program Fi | es\ Energy M cro\ boar ds\ EFM32_Gxxx_DK\ exanpl es\

The examples include, among others

* blink - Simple application using the DVK and it's LED control API
» peripherals - Toggles peripherals on and off, indicated by LEDs on the board
* joystick - Use DVK LED, joystick and interrupt APIs for indicating DVK joystick movement
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The example files above have been configured to be built for both the EFM32_G2xx_DK and
EFM32_G8xx_DK kits, with the EFM32G290F128 and EFM32G890F128 part numbers. Select the
project that matches your setup to ensure correct operation.

7.5 How to include in your own applications

The easiest way to include the BSP in your application is to base your work on one of the example
applications, for instance the easy "blink" demonstration. The following items are recommended for
correct configuration:

1. Make sure you define the correct part number (e.g. EFM32G290F128) as a preprocessor defined
symbol

2. Make sure you define the correct part number (e.g. EFM32G290F128) for your IAR EWARM / Keil
MDK-ARM project

3. Add and include the EFM32_CMSIS-files (startup_efm32.s, system_efm32.c, core_cm3.c) to your

project

. Add and include _all_ BSP package .c-files, with the dvk-prefix to your project

5. Configure include paths to point at the CMSIS/CM3/CoreSupport and CMSIS/CM3/DeviceSupport/
EnergyMicro/EFM32 directories

6. Configure include paths to point to the dvk/bsp directory

N

Make sure you call "DVK_init()" early at startup, and you should be all set.

7.6 Chip errata

Early versions of the development kit are shipped with EFM32 Engineering Samples on the MCU
modules. There has been updates to configuration and reset values that needs to be configured correctly
on these early parts. We recommend always starting your application with a call to

#i ncl ude "ef n82_chi p. h"

CH P_Init();

to ensure correct and stable behavior. This function is found in EFM32_CMSIS (version 1.3.0 or later).
See the BSP examples for details. We recommend also to download and read the latest errata from the
Energy Micro website for your part number.
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8 Configuration

Some parameters can be configured using the GUI. The other parameters, such as peripheral control,
can be controlled by software. See the Board Controller chapter for details.

8.1 MCU voltage

The MCU voltage can be set by entering the CFG page from the main page. Use the joystick to navigate
to VMCU and set your desired voltage by moving the joystick sideways. The measured VMCU can be
read at the bottom of this screen. Push Save to store your settings.

8.2 Debug settings

The debug routing can be set by entering the CFG page from the main page. Use the joystick to navigate
to Debug Control and set your desired mode by moving the joystick sideways. Push Save to store your
settings.

See the debug chapter to read more about the different modes.
8.3 Peripheral configuration
The peripheral configuration can be set by entering the CFG page from the main page and then entering

the Peri page. All peripherals connected to the EFM can be en- or disabled individually using the list
displayed in the GUI.

8.4 Program MCU

To program the MCU with files uploaded to the flash, enter the Flash page from the main page. The
list of available binaries are shown, and one of them can be selected by using the joystick. When the
desired binary has been selected, push Flash to program the MCU. While programming, a new page
shows with a progress bar. A status message appears when the programming is finished.

Note
The debug mode has to be set to MCU for this to work.

8.5 Upload files

To upload files, Gecko Commander must be used. This is an executable that can be found in the install
location, typically:

C:\Program Fi | es\ Energy M cro\ EFM32 Kit Package\ GeckoCrd\ Gecko. exe
After launching the program, execute this command in Gecko Commander:
put your_binary file.bin \flash\your_binary _file.bin

To see the commands available, execute this command for help:
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9 Advanced Energy Monitor
9.1 AEM Display

To enter AEM from the main page, press the pushbutton under the display labeled AEM. If the EFM
is using the display, press the AEM button at the right side of the display, and the board controller will
take control of the display and show the AEM. To return to EFM control, simply press the AEM button
once more.

When the AEM is entered, you will get a real-time graphical display of the current consumption of the
EFM and other circuits powered by the VMCU power rail. The AEM display mainly features a plot of
current the consumption over time. It also displays the latest sampled current consumption and voltage.

9.2 AEM configuration

There are several parameters that can be configured on the AEM. To configure AEM, first enter the
AEM page. Then push the button labeled CFG. In the CFG page, you can adjust the scale of the time
axis of the current plot.

9.3 AEM theory of operation

In order to be able to measure currents ranging from 0.1uA to 50mA (114dB dynamic range), two current
sense amplifiers are utilized. The amplifiers measure voltage drop over a small series resistor and
translates this into a current. Each amplifier is adjusted for current measurement in a specific range.
The ranges for the amplifiers overlap and a change between the two occurs when the current is 200uA.
To reduce noise, averaging of the samples is performed before the current measurement is presented
in the AEM GUI.

During startup of the kit and when VMCU is changed, a calibration of the AEM is performed. This
calibration compensates for the offset error in the sense amplifiers. In order for the calibration to be
correct, no load should be connected between the pins of ST6 during calibration.

9.4 AEM accuracy and performance

The Advanced Energy Monitor is capable of measuring currents in the range of 0.1uA to 50mA. For
currents above 200uA, the AEM is accurate within 0.1mA. When measuring currents below 200uA, the
accuracy increases to 1uA. Even though the absolute accuracy is 1UA in the sub 200uA range, the AEM
is able to detect changes in the current consumption as small as 100nA. The measurement bandwidth
of the AEM is 60Hz when measuring currents below 200uA and 120Hz when measuring currents above
200uA. The table below summarizes accuracy of the two current sense amplifiers in different ranges.

Table 9.1. AEM accuracy

Current range Low gain amplifier accuracy High gain amplifier accuracy
50mA 0.1mA
1ImA 0.1mA
200uA 0.01mA 1uA
10uA 0.1uA
1uA 0.1uA
Note

In order for the AEM to work correctly, VMCU should be 3.0V or higher.
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10 Board controller

The board controller (BC) consists of the control MCU and an FPGA. The FPGA is essentially a
programmable multiplexer that allows the resources on the board to be shared between the EFM and
the control MCU. It also enables jumperless peripheral configuration. The control MCU implements the
built-in debugger, the AEM and performs housekeeping tasks.

To use the board controller for your application, the Board Support Package (BSP) must be installed.

See the BSP chapter to find out how.

10.1 Register Map

The offset register address is relative to the registers base address.

0x000 BC_BC_CFG RW Board Controller Config register
0x002 BC_EM RW Energy Mode register
0x004 BC_MAGIC R Magic number

0x006 BC_LED RW User LEDs register

0x008 BC_PUSHBUTTON R User pushbutton status register
0x00A BC_DIPSWITCH R User dipswitch status register
0x00C BC_JOYSTICK R Joystick state register
0x00E BC_AEM R AEM button status register
0x010 BC_DISPLAY_CTRL RW Display control register
0x012 BC_EBI_CFG RW EBI configuration register
0x014 BC_BUS_CFG RW BUS configuration register
0x018 BC_PERCTRL RW Peripheral control register
0x01A BC_AEMSTATE R AEM button status register
0x01C BC_SPI_CFG RW SPI configuration register
Ox01E BC_RESET RW Reset register

0x020 BC_ADC_START RW ADC start byte register
0x022 BC_ADC_STATUS R ADC status register

0x024 BC_ADC_DATA R ADC data register

0x028 BC_HW_VERSION R Hardware version register
0x02A BC_FW_BUILDNO R Firmware build number
0x02C BC_FW_VERSION R Firmware version register
0x02E BC_SCRATCH_COMMON RW Common scratch register
0x030 BC_SCRATCH_EFMO RW EFM scratch register 0
0x032 BC_SCRATCH_EFM1 RW EFM scratch register 1
0x034 BC_SCRATCH_EFM2 RW EFM scratch register 2
0x036 BC_SCRATCH_EFM3 RW EFM scratch register 3
0x038 BC_SCRATCH_BCO RW BC scratch register O
0x03A BC_SCRATCH_BC1 RW BC scratch register 1
0x03C BC_SCRATCH_BC2 RW BC scratch register 2
0Xx03E BC_SCRATCH_BC3 RW BC scratch register 3
0x040 BC_INTFLAG RW Interrupt flags

0x042 BC_INTEN RW Interrupt enables
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10.2 Register Description

10.2.1 BC_BC_CFG - Board Controller Config register

Offset Bit Position

0x000 B i et o b S o © ~ © ) “ o

Reset

Access 5
©

Name S
o
@

Bit Name Reset Access Description

15:1 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???

0 BC_CFG 0 RW Board controller configuration

Use this bit to change between SPI and EBI interface on the board controller

Value Mode Description
0 SPI The BC is configured to use the SPI interface.
1 EBI The BC is configured to use the EBI interface.

10.2.2 BC_EM - Energy Mode register

Offset Bit Position
0x002 i S et N o S o © ™~ © 1} < ™ o~ - <}
Reset <
o
Access E
Name E
Bit NEE] Reset Access Description
15:3 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ?2??
2:0 EM 0x0 RW Energy Mode register

This register is used to store the Energy Mode the EFM is running in.

10.2.3 BC_MAGIC - Magic number

Offset Bit Position
0x004 i 3 et N o S o © ~ © 1} < ™ o~ - <}
o
o
Reset i
x
S
Access x
O
Name 0}
<
=

www.energymicro.com
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Bit Name Reset Access Description

15:0 MAGIC OXEF32 R Magic number

This register can be used to test the interface.

10.2.4 BC_LED - User LEDs register

Offset Bit Position
0x006 9 S a o o S o © ™~ © 1} < ™ o~ — <}
o
o
Reset S
3
Access E
Name B
—
Bit NE ] Reset Access Description
15:0 LED 0x0000 RW User LED register

Write to this register to change the DVK user leds

10.2.5 BC_PUSHBUTTON - User pushbutton status register

Offset Bit Position
0x008 B 3 et N o S o © ™~ © 1} < ™ o~ — <}
Reset =

o
Access @

z

o
Name E

om

I

%}

>

o
Bit NETE) Reset Access Description
15:4 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???
3:0 PUSHBUTTON 0x0 R User pushbutton status register

Read this register to determine the state of the pushbuttons

10.2.6 BC_DIPSWITCH - User dipswitch status register

Offset Bit Position

0x00A 9 3 et N o S o © ™~ © 1} < ™ o~ - <}
o

Reset a
S

Access @
5

Name =
=2
[
a
[a)]
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Bit Name Reset Access Description
15:8 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???
7:0 DIPSWITCH 0x00 R User dipswitch status register

Read this register to determine the state of the dipswitch

10.2.7 BC_JOYSTICK - Joystick state register

Offset Bit Position
0x00C v 3 et o o S o © ~ © 1} < ™ o~ — =}
Reset o o o o o
Access @ @ @ @ o
o z

Name % E g é §
Bit Name Reset Access Description
15:5 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???
4 CENTER 0 R Joystick CENTER switch state register

Read this register to get the status of the center switch of the joystick.
3 LEFT 0 R Joystick LEFT switch state register

Read this register to get the status of the left switch of the joystick.
2 UP 0 R Joystick UP switch state register

Read this register to get the status of the up switch of the joystick.
1 RIGHT 0 R Joystick RIGHT switch state register

Read this register to get the status of the right switch of the joystick.
0 DOWN 0 R Joystick DOWN switch state register

Read this register to get the status of the down switch of the joystick.

10.2.8 BC_AEM - AEM button status register

Bit Position

0x00E v i et N o S o © ~ © 0 < ™ o~ - =}
Reset o
Access @
Name &

<
Bit Name Reset Access Description
15:1 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ?2??
0 AEM 0 R AEM button status register

Read this register to determine the state of the AEM button
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10.2.9 BC_DISPLAY_CTRL - Display control register

Offset Bit Position
0x010 v 3 “9 o o S o © ~ © 0 < ™ o~ — o
Reset o o
Access 5 5
L
-
S | -
Name & o
I |
5 4
=
o
o
Bit Name Reset Access Description
15:2 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ?2??
1 POWER_ENABLE 0 RW Display power enable
Set this bit to enable power to the TFT display
0 RESET 0 RW Display reset

Set this bit to put the TFT display into reset mode

10.2.10 BC_EBI_CFG - EBI configuration register

Offset Bit Position

0x012 9 3 et N o S o © ~ © 1} < ™ o~ - <}

Reset §<>
o

Access E
2

Name OI
m
L

Bit Name Reset Access Description

15:2 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???

1:0 EBI_CFG 0x0 RW EBI configuration register

Set this register to configure the BC EBI interface to match the configuration in your application

Value Mode Description

0 EBI_16_16 The BC EBI is in a 16 address bits and 16 data bits configuration
1 EBI_8_8 The BC EBIl is in a 8 address bits and 8 data bits configuration

2 EBI_24_8 The BC EBIl is in a 24 address bits and 8 data bits configuration

10.2.11 BC _BUS_CFG - BUS configuration register

Offset Bit Position
0x014 v 3 et o o S o © ™~ © 0 < ™ o~ — o
Reset =

o
Access E

2
Name OI

%)

>

o
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Bit Name Reset Access Description
15:2 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???
1:0 BUS_CFG 0x0 RW BUS configuration register

Set this register to configure which bus has access to the SRAM, Nor Flash and TFT display.

Value Mode Description

0 FSMC The FSMC has access

1 EBI The EBI interface has access
2 SPI The SPI interface has access

10.2.12 BC_PERCTRL - Peripheral control register

Offset Bit Position

0x018 © hA « N hu S o © ~ © n < ™ o~ — o
Reset o o o o o o o o o o o o o o o o
Access E E E & E x E E x x E x z o
P4 Z -
= = %) — — L L 4
8 8 = 7 z 3 % @, o < o 5 _
Name = E L o [ S, | 0] py %) T § S W a u
=) 2 ] 4 o o [0} e} T N »n I I = o 8
I 5 %) o a = e | = ) ) [= g g
» 0 [ O =) a 2 < X X o 2
| N — 3 = > < z Y <
< » [} < < z <
[a) I Q <
x %) 3]
= 14 <
Bit Name Reset Access Description
15 IRDA_SHUTDOWN 0 RW Shut down IrDA transceiver
Set this bit to shut down the IrDA transceiver
14 RS232_SHUTDOWN 0 RW Shut down RS232 driver
Set this bit to shut down the RS232 driver. It is strongly recommended that this is done when the application does not use RS232.
13 ACCEL_SELFTEST 0 RW Accelerometer selftest mode
Set this bit to put the accelerometer into selftest mode
12 ACCEL_GSEL 0 RW Accelerometer g-select
Use this bit to configure the g-range of the accelerometer
Value Mode Description
0 LOW The g-range is up to 1.5g
1 HIGH The g-range is up to 6g
11 AUDIO_IN 0 RW Audio in connect
Set this bit to connect the audio in amplifier to the EFM
10 AUDIO_OUT 0 RW Audio out connect
Set this bit to connect the audio out amplifier to the EFM
9 ANALOG_DIFF 0 RW Analog differential input connect
Set this bit to connect the analog differential inputs to the EFM
8 ANALOG_SE 0 RW Analog single ended input connect
Set this bit to connect the analog single ended inputs to the EFM
7 IRDA 0 RW IrDA connect
Set this bit to connect the IrDA transceiver to the EFM
6 12C 0 RW 1°C bus connect
Set this bit to connect the 12C devices to the EFM
5 SPI 0 RW SPI bus connect
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Bit Name Reset Access Description

Set this bit to connect the SPI devices to the EFM

4 RS232B 0 RW RS232B connect
Set this bit to connect the RS232 B to the EFM

3 RS232A 0 RW RS232A connect
Set this bit to connect the RS232 A to the EFM

2 POTMETER 0 RW Potmeter connect
Set this bit to connect the potmeter to the EFM

1 AMBIENT 0 RW Ambient light sensor connect

Set this bit to connect the ambient light sensor to the EFM

0 ACCEL 0 RW Accelerometer connect

Set this bit to connect the accelerometer chip to the EFM

10.2.13 BC_AEMSTATE - AEM button status register

Bit Position

0x01A v 3 et o o S o © ~ © 0 < ™ ~ - o
Reset o
Access x
Name E

<
Bit Name Reset Access Description
15:1 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???
0 AEM 0 R AEM state register

When this bit is 0, the BC can take control of the TFT display, and when 1 the EFM can take control. This bit is toggled by the
AEM button push

10.2.14 BC_SPI_CFG - SPI configuration register

Offset Bit Position
0x01C 9 A et o o S o ) ~ © 0 < ™ o — o
Reset
Access E
2
Name o|
o
%)
Bit Name Reset Access Description
15:1 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???
0 SPI_CFG 0 RW SPI configuration register
This register selects which SPI module will receive the CS signal
Value Mode Description
0 FLASH The SPI CS is routed to the SPI Flash
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Bit Name Reset Access Description
Value Mode Description
1 MICROSD The SPI CS is routed to the microSD

10.2.15 BC_RESET - Reset register

Offset Bit Position

0x01E v 3 et o o S o © ~ © n < ™ o~ — o

Reset

Access E E
I

Name = 7]

T

(TR

Bit Name Reset Access Description

15:2 Reserved To ensure compatibility with future devices, always write bits to 0. More information on 2?2

1 EFM 0 RW EFM reset signal

Set this bit to put the EFM into a reset state
0 FLASH 0 RW Flash reset signal

Set this bit to put the Nor flash into a reset state

10.2.16 BC_ADC_START - ADC start byte register

Offset Bit Position
0x020 v 3 “ o o S o © ~ © 0 < ™ o~ - o
o
Reset <
o
Access z
[
o
Name ff
9
)
a
<
Bit Name Reset Access Description
15:8 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???
70 ADC_START 0x00 RW ADC start byte

Write this byte to start a conversion on the voltage monitor ADC. The content of the byte is equal to the start byte for the ADC itself.

10.2.17 BC_ADC_STATUS - ADC status register

Bit Position
0x022 9 s < o b =1 o © ™~ © 0 < ™ o~ — o
Reset o
Access x
Name 5
-]
o
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Bit Name Reset Access Description
15:1 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???
0 BUSY 0 R ADC status byte

Read this bit to determine the state of the ADC conversion

Value Mode Description
0 DONE The ADC is not doing a conversion
1 BUSY The ADC is busy doing a conversion

10.2.18 BC_ADC _DATA - ADC data register

Bit Position

0x024 v b et o o S o © ~ © 0 < ™ o~ — o

o

o
Reset 8

x

o
Access x

'_

@
Name Z

9

6}

a

<
Bit NE ] Reset Access Description
15:0 ADC_START 0x0000 R ADC data register

This register contains the result of the latest conversion

10.2.19 BC_HW _VERSION - Hardware version register

Offset Bit Position
0x028 v s <9 o ] S o © ~ © 0 < ™ o~ - o
Reset < S}

o o
Access @ 2

@ £
Name

g 5

m
Bit Name Reset Access Description
15:11 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???
10:8 PCB 0x0 R PCB revision
Read these bits to determine the PCB revision

74 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ???
3:0 BOARD 0x0 R Board revision

Read these bits to determine the board revision
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10.2.20 BC_FW_BUILDNO - Firmware build number

Bit Position

0x02A i 3 et N o =1 o © ™~ © 1} < ™ o~ - <}

o

o
Reset 8

x

o
Access 24

o}
Name Z

=

o]

m
Bit NE ] Reset Access Description
15:0 BUILDNO 0x0000 R Board revision

Read this register to determine the firmware build number

10.2.21 BC_FW_VERSION - Firmware version register

Bit Position
0x02C 9 A “9 o o S o ) ~ © 0 < ™ N - o
Reset 2 2 §
S S 3
Access 14 [ 24
m
o x
Name Q o E
< =z T
= = O
<
o
Bit Name Reset Access Description
15:12 MAJOR 0x0 R Firmware major revision
Read these bits to determine the major revision
11:8 MINOR 0x0 R Firmware minor revision
Read these bits to determine the minor revision
7:0 PATCHLEVEL 0x00 R Firmware patch level

Read these bits to determine the patch level

10.2.22 BC_SCRATCH_COMMON - Common scratch register

Offset Bit Position
0x02E B 3 et o o S o © ™~ © 1} < ™ o~ — o

o

S
Reset S

%

IS}
Access E

=z

o

=

3
Name UI

I

O

=

<<

@

Q

o

2010-11-12 - t0006_1.11 www.energymicro.com




EFNVI32 ...the world's most energy friendly microcontrollers

Bit Name Reset Access Description

15:0 SCRATCH_COMMON 0x0000 RW Common scratch register

This register can be used as a scratch register for both the EFM and the board controller.

10.2.23 BC_SCRATCH_EFMO - EFM scratch register 0

Offset Bit Position
0x030 v 3 “ o ] S o © ~ © 0 < ™ o~ — o
o
o
Reset 8
3
Access 5
o
=
i
Name II
=)
<
o
O
2]
Bit Name Reset Access Description
15:0 SCRATCH_EFMO 0x0000 RW EFM scratch register 0

This register can be used as a scratch register for the EFM. The board controller has read only access.

10.2.24 BC_SCRATCH_EFML1 - EFM scratch register 1

Offset Bit Position
0x032 9 A et N o S o © ~ © 1} < ™ o~ - <}
o
o
Reset 8
x
o
Access E
-
=
]
Name II
O
[t
<
@
O
n
Bit Name Reset Access Description
15:0 SCRATCH_EFM1 0x0000 RW EFM scratch register 1

This register can be used as a scratch register for the EFM. The board controller has read only access.
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10.2.25 BC_SCRATCH_EFM2 - EFM scratch register 2

Bit Position
0x034 © 3 « N o S () ® ~ © 1o) < ™ o~ — o
o
o
Reset S
3
Access E
[aN]
=
TR
N 4
ame I
O
'_
<
@
O
(2]
Bit Name Reset Access Description
15:0 SCRATCH_EFM2 0x0000 RW EFM scratch register 2

This register can be used as a scratch register for the EFM. The board controller has read only access.

10.2.26 BC_SCRATCH_EFMS3 - EFM scratch register 3

Offset Bit Position
0x036 9 3 et o o S o © ™~ © 1} < ™ o~ — o
o
o
Reset S
3
Access 2
(a2}
=
TR
N 4
ame I
O
'_
<
o
O
n
Bit Name Reset Access Description
15:0 SCRATCH_EFM3 0x0000 RW EFM scratch register 3

This register can be used as a scratch register for the EFM. The board controller has read only access.

10.2.27 BC_SCRATCH_BCO - BC scratch register 0

Offset Bit Position
0x038 9 3 et o o S o © ™~ © 1} < ™ o~ — o

o

o
Reset S

x

o
Access E

o

O

@
Name I

O

=

<<

I

Q

%)
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Bit Name Reset Access Description

15:0 SCRATCH_BCO 0x0000 RW BC scratch register 0

This register can be used as a scratch register for the BC. The EFM has read only access.

10.2.28 BC_SCRATCH_BC1 - BC scratch register 1

Offset Bit Position
0x03A v S et o b S o © ™~ © 0 < ™ o~ — =}
o
o
Reset 8
3
Access 5
I
O
m
Name :|:|
o
<
o
[}
2]
Bit Name Reset Access Description
15:0 SCRATCH_BC1 0x0000 RW BC scratch register 1

This register can be used as a scratch register for the BC. The EFM has read only access.

10.2.29 BC_SCRATCH_BC2 - BC scratch register 2

Offset Bit Position
0x03C 9 A et N o S o © ™~ © 1} < ™ o~ - <}
o
o
Reset 8
x
o
Access E
N
O
o
Name I'
O
[t
<
o
O
@
Bit Name Reset Access Description
15:0 SCRATCH_BC2 0x0000 RW BC scratch register 2

This register can be used as a scratch register for the BC. The EFM has read only access.
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10.2.30 BC_SCRATCH_BC3 - BC scratch register 3

Offset Bit Position
O0x03E 9 3 et o o S o © ™~ © 1} < ™ o~ - <}
o
o
Reset 8
x
o
Access E
o™
O
o
Name II
O
'_
<
o
O
n
Bit Name Reset Access Description
15:0 SCRATCH_BC3 0x0000 RW BC scratch register 3

This register can be used as a scratch register for the BC. The EFM has read only access.

10.2.31 BC _INTFLAG - Interrupt flags

Bit Position
0x040 B S et o b S o © ~ © I < ™ o~ “ o
Reset
Access 5 E 5
s | &
Name = o o
< b | © o
>-
o
k)
Bit Name Reset Access Description
15:4 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ?2??
3 AEM 0 RW AEM interrupt flag
This bit is set when the AEM button is pushed or released. It will assert an interrupt to the EFM if the interrupt has been enabled.
This bit is cleared by writing a 1 to it.
2 JOYSTICK 0 RW Joystick interrupt flag
This bit is set when the joystick changes position, or is pushed or released. It will assert an interrupt to the EFM if the interrupt has
been enabled. This bit is cleared by writing a 1 to it.
1 DIP 0 RW Dipswitch interrupt flag
This bit is set when any of the dipswitch positions are changed. It will assert an interrupt to the EFM if the interrupt has been enabled.
This bit is cleared by writing a 1 to it.
0 PB 0 RW Pushbuttons interrupt flag

This bit is set when any of the 4 pushbutton are pushed or released. It will assert an interrupt to the EFM if the interrupt has been
enabled. This bit is cleared by writing a 1 to it.
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10.2.32 BC_INTEN - Interrupt enables

Offset Bit Position
0x042 9 3 « N o S () © ~ © 1o) < ™ o~ — =]
Reset (=) (=) [} o
Access z z z
Name = 8 o @
< | b |8 | &
5
Bit NETg[] Reset Access Description
15:4 Reserved To ensure compatibility with future devices, always write bits to 0. More information on ?2??
3 AEM 0 RW AEM interrupt enable
If this bit is set, an interrupt is asserted when the corresponding interrupt flag is set.
2 JOYSTICK 0 RW Joystick interrupt enable
If this bit is set, an interrupt is asserted when the corresponding interrupt flag is set.
1 DIP 0 RW Dipswitch interrupt enable
If this bit is set, an interrupt is asserted when the corresponding interrupt flag is set.
0 PB 0 RW Pushbuttons interrupt enable

If this bit is set, an interrupt is asserted when the corresponding interrupt flag is set.
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11 Connectivity

11.1 Resource connections

In general, all ports are routed from the BRD3300B to the prototyping board. That means that Port A on
the EFM is replicated on Port A on the prototyping board. In addition to that, a lot of EFM pins has been
connected to other resources on the board, some using switches and some permanent.

The following table describes the connections between the EFM on the BRD3300B and the kit resources.

Table 11.1. Connections

A0 EBI_AD9 B25 |BC_BUS_CONNECT EBI |B25 |G12 |BC_BUS9

Al EBI_AD10 B26 BC_BUS_CONNECT_EBI | B26 G13 BC_BUS10

A2 EBI_AD11 B27 BC_BUS_CONNECT_EBI | B27 Gl14 BC_BUS11

A3 EBI_AD12 B28 BC_BUS_CONNECT_EBI | B28 G15 BC_BUS12

A4 EBI_AD13 B29 BC_BUS_CONNECT_EBI | B29 G16 BC_BUS13

A5 EBI_AD14 B3 BC_BUS_CONNECT_EBI |B30 |G17 |BC_BUS14

A6 EBI_AD15 B31 BC_BUS CONNECT_EBI |B31 G18 BC_BUS15

Al5 EBI_ADS8 B24 BC_BUS CONNECT_EBI |B24 Gl1 BC_BUSS8

B7 US1_CLK #0 B53 RS232_A B53 J4 RS232_A #CTS

B8 US1 CS#0 B54 RS232_A B54 J5 RS232_A #RTS

B11 DACO_OUTO B48 AUDIO_OUT B48 17 AUDIO_OUT_RIGHT
B12 DACO_OUT1 B49 AUDIO_OUT B49 18 AUDIO_OUT_LEFT
Co US1_TX #0 B55 | RS232_A B55 | J6 RS232_A _TX

C1l US1 _RX#0 B52 RS232_A B52 J3 RS232_A RX

c2 US2_TX #0 B42 BC_BUS_CONNECT_SPI |B42 H13 | BC_BUS26

C3 US2_RX #0 B43 BC_BUS_CONNECT_SPI | B43 H14 BC_BUS27

C4 US2_CLK #0 B40 BC_BUS_CONNECT_SPI | B40 H11 BC_BUS24

c5 US2_CS #0 B41 |BC_BUS_CONNECT SPI |B41 |H12 |BC_BUS25

C6 LEU1_TX #0 B62 RS232_B B62 J9 RS232 B TX

c7 LEU1 RX#0 |B63 RS232 B B63 | J10 RS232_B_RX

C8 USO_CS #2 B65 SPI B65 J12 SPI_BUS_#CS

(0] USO_CLK #2 B64 SPI B64 J11 SPI_BUS_SCLK

C10 USO_RX #2 B67 SPI B67 Ji4 SPI_BUS_MISO

C11 USO_TX #2 B66 SPI B66 Ji3 SPI_BUS_MOSI

Cc12 B72 | Connected B72 |H15 |BC_BUS_CONNECT_EBI
C13 Connected FPGA_#INT

C15 B79 Connected B79 J18 MCUDBG_TDO_SWO
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DO ADC_CHO B50 | AUDIO_IN B50 |19 AUDIO_IN_RIGHT
D1 ADC_CH1 B51 | AUDIO_IN B51 |[110 AUDIO_IN_LEFT
D2 ADC_CH2 B56 | ACCEL B56  |I11 ACCEL_XOUT

D3 ADC_CH3 B57 | ACCEL B57 |[112 ACCEL_YOUT

D4 ADC_CH4 B58 | ACCEL B58  |[113 ACCEL_zZOUT

D5 ADC_CH5 B70 |POTMETER B70 |[115 SENSOR_POTMETER
D5 ADC_CH5 B71 | AMBIENT B71 |[116 SENSOR_LIGHT
D6 ADC_CH6 B46 | ANALOG_DIFF B46 |I5 ANALOG_DIFF_N
D7 ADC_CH7 B47 | ANALOG_DIFF B47 |16 ANALOG_DIFF_P
D9 EBI_CSO B36 |BC_BUS CONNECT EBI |B36 |H7 BC_BUS20

D10 |EBI_CS1 B37 |BC_BUS CONNECT EBI |B37 |H8 BC_BUS21

D11 |EBI_CS2 B38 |BC_BUS CONNECT EBI |B38 |H9 BC_BUS22

D12 |EBI_CS3 B39 |BC_BUS CONNECT EBI |B39 |H10 |BC_BUS23

D14 |12CO_SDA#3 [B68 |I2C B68 [J15 |12C_BUS_SDA
D15 |12CO_SCL#3 [B69 |I2C B69 |J16 |I12C_BUS_SCL

E6 USO_RX #1 B61 |IRDA B61 |J8 IRDA_RXD

E7 USO_TX #1 B60 |IRDA B60 |J7 IRDA_TXD

ES EBI_ADO Bl16 |BC_BUS_CONNECT EBI |B16 |G3 BC_BUSO

E9 EBI_AD1 B17 |BC_BUS_CONNECT EBI |B17 |G4 BC_BUS1

E10 |EBI_AD2 B18 |BC_BUS_CONNECT EBI |B18 |G5 BC_BUS2

E11 |EBI_AD3 B19 |BC_BUS CONNECT EBI |B19 |G6 BC_BUS3

E12 |EBI_AD4 B20 |BC_BUS_CONNECT EBI [B20 |G7 BC_BUS4

E13 | EBI_AD5 B21 |BC_BUS _CONNECT EBI [B21 |G8 BC_BUS5

E14 |EBI_AD6 B22 |BC_BUS CONNECT EBI [B22 |G9 BC_BUS6

E15 |EBI_AD7 B23 |BC_BUS_CONNECT EBI |B23 |G10 |BC_BUS7

FO DGB_SWCLK |B77 | Connected B77 |118 MCUDBG_TCK_SWCLK
F1 DGB_SWDIO |B78 | Connected B78 [J17 | MCUDBG_TCK_SWDIO
F2 EBI_ARDY B32 |BC_BUS CONNECT EBI |B32 |H3 BC_BUS16

F3 EBI_ALE B33 |BC_BUS CONNECT EBI |B33 |H4 BC_BUS17

F4 EBI_WEn B34 |BC_BUS_CONNECT EBI |B34 |H5 BC_BUS18

F5 EBI_REn B35 |BC_BUS CONNECT EBI |B35 |H6 BC_BUS19
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Table 11.2. Nomenclature

Name Description ‘

MCU The pin name of the MCU

MCU function The 1/O function on that pin that is used for this resource

EFM32_B The corresponding pin number on the EFM32_B connector. If this is empty, the signal is not routed out
from the BRD3300B

Connection Which API function is used to make the connection.

EXP32_B The corresponding pin number on the EXP32_B connector. If this is empty, the signal is not routed out
from the BRD3300B

Proto port The corresponding pin on the proto board

Function The name of the kit resource
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12 Connectors
12.1 EFM32 and EXP32 connectors

The EFM32 connector is used to connect the MCU plugin board to the main board, and the EXP32
connector is used to connect the prototype card to the main board. The EFM32_A connector and the first
16 pins of the EFM32_B connector is directly connected to the corresponding pins on the EXP32_A and
EXP32_B connectors. These signals duplicate the MCU ports to the port headers on the prototype board.

Some care must be taken when fitting and removing the plugin cards. Make sure that the plugin boards
sits properly in place to ensure good connections. The connectors are rated for 100 plugin cycles.

For pinout check the schematics.

12.2 Debug connector

This connector is used for Debug In and Debug Out (see Debug chapter). The pinout is described in
the table.

Table 12.1. Debug connector pinout

1 VTARGET Target voltage on the debugged application.

2 NC

3 ITRST JTAG tap reset

4 GND

5 TDI JTAG data in

6 GND

7 TMS/SWDIO JTAG TMS or Serial Wire data I/O

8 GND

9 TCK JTAG TCK or Serial Wire clock

10 GND

11 RTCK JTAG RTCK

12 GND

13 TDO/SWO JTAG TDO or Serial Wire Output

14 GND

15 /RESET Target MCU reset

16 GND

17 PD This pin has a 100k pulldown.

18 Cable detect This signal must be pulled to ground by the external debugger or application for cable
insertion detection.

19 PD This pin has a 100k pulldown.

20 GND
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13 Debugging

The EFM32-G2XX-DK has an on-board debugger, and it can be used in different ways to debug the
EFM, both on and off kit. Below are descriptions on the different modes. Check the configuration chapter
to find out how to change the debug setting.

Table 13.1. Debug modes

Mode Description ‘
Debug MCU In this mode the built-in debugger is connected to EFM on the BRD3300B.
Debug IN In this mode the built-in debugger is disconnected, and an external debugger can be connected to

debug the EFM on the BRD3300B.

Debug OUT In this mode the built-in debugger can be used to debug an EFM mounted in your own application.
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14 Integrated Development Environments

The Energy Micro software packages contains various examples in source form to use with the Starter
Kit. The following IDEs are supported.

14.1 IAR Embedded Workbench for ARM

An evaluation version of IAR Embedded Workbench for ARM is included on a CD in the EFM32-G2XX-
DK package. Check the quick start guide for where to find updates, and IAR's own documentation on
how to use it. You will find the IAR project file in the

i ar

subfolder of each project

14.2 Rowley Associates - CrossWorks for ARM

See the quick start guide for download details for CrossWorks for ARM. You will find CrossWorks project
files in the

row ey

subfolder of each project.

14.3 CodeSourcery - Sourcery G++

See the quick start guide for download details for Sourcery G++. The
codesour cery

subfolder contains Makefiles for use with the Sourcery G++ development environment.

14.4 Keil - MDK-ARM

See the quick start guide for download details for evaluation versions of Keil MDK-ARM. The

arm

subfolder in each project contains project files for MDK-ARM. Please see the MDK-ARM documentation
for usage details.
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15 energyAware Commander and Upgrades

energyAware Commander is a program that comes with the Gecko DK Installer package. It can perform
various kit and EFM32 specific tasks. The program has two modes of operation, either command line or
GUI mode. The command line is not backwards compatible with the earlier "Gecko Commander” shell
utility, but support all features of that package.

15.1 GUI Operation

The primary use of energyAware Commander is in the GUI mode. This utility gives the ability to program
the EFM32, upgrade the kit, lock and unlock devices and more. Some of the features will only work
with Energy Micro kits, while other will work with a J-Link debugger connected. Press the "F1" button,
or select the "Help->Help" menu item for a full description.

15.2 Command Line operation

Using the command line involves runnig the binary in a command shell, with an appropriate argument,
e.g.

eACommander . exe --help

All command line options will be parsed in the other they are given, so multiple commands can be run.

Table 15.1. energyAware Commander command line options

--version

Prints version and exits

--help (-h)

Prints this help information

--flash image.bin (-f)

Flash binary file to EFM32

--install package.emz (-i)

Install kit firmware

--mcuinfo Print MCU information
--kitinfo Print Kit information
--usb 0-3 (-u) Specify USB address

--speed wanted speed (-s)

Set SWD speed (in kHz)

--verify (-v)

Verify flash after upload

--mode in|out|mculoff (-m)

Set debug mode

--unlock Unlock a locked chip
--lock (-1) Lock a chip

--reset (-r) Reset the EFM32
--unprotect Unprotect pages

--protect start stop

Protect pages

--upload file

Upload files to DVK

The mode option argument Sets the mode of the on-board debugger. Available modes:

mcu - Debug the EFM32 using the on-board debugger
in - Debug the EFM32 using an external debugger

out - Use the DK as an external debugger

off - Disable the debugger

WWWw.energymicro.com
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15.3 Upgrades

Upgrading the kit can be done by using the "Upgrade Kit" script in the start menu. New versions
can be downloaded from http://www.energymicro.com/downloads/. The script will use energyAware
Commander to install the latest available Kit SW package. Itis important to upgrade the kit when installing
a new SW package, as new energyAware Commander functionality might require kit controller software
upgrades.

You can also use the energyAware Commander for upgrades. Select the "Kit" icon, use the "Browse"
button to select the correct file ending in ".emz", and press the "Install package button".

Finally, there is an option at the command line,
eACommander . exe --install dvkappl.enz

to explictly install new packages by hand (or within a script).
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16 Version information

The current version information can be read from the EFM32-G2XX-DK by entering the About page from
the main page in the GUI, and then pushing Info.

Table 16.1. Current versions

Type Version Released ‘
Firmware revision 1v6p0 2010-11-15
FPGA version vl 2009-11-13
Motherboard BRD3200C Rev.A01 2009-11-13
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17 MCU board

The EFM32-G2XX-DK is equipped with the BRD3300B. The main features are listed here, but for a
complete overview, check the BRD3300B user manual.

Features:

» The worlds most energy friendly microcontroller

e Compatible with the Advanced Energy Monitoring (AEM) system of the EFM32 Gecko Development
Kit

* Leds indicating power and reset

e 32 MHz crystal

* 32.768 kHz crystal

* Reset button and ground-hooks for easy debugging

e e ‘ &
000000000000 000000000000

®

Voltage
indicators

The worlds most energy ~ 32.768kHz Reset
friendly microcontroller Crystal Button
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18 Prototyping Board

The EFM32-G2XX-DK is equipped with a prototyping board. The main features are listed here, but for
a complete overview, check the prototyping board user manual.

18.1 Overview
Features:

* Ready-to-use prototyping area for hole-mount, TSSOP, SO, SOT23-6, SOT23 and 0805 SMD
components.

* VMCU power domain tracked by the Advanced Energy Monitor (AEM).
» 3.3V and 5V power domains available.

» All EFM32 IO lines directly accessible through pin headers.

» User LEDS ready for use.

» LEDS indicating power.

Pin Headers

fiaasganAasan

T Thir B T L o [ bl T P o o b ] e e B o

.......

VMCU LED — 5 SR bbbl PN bl 81— 5\ LED
; R ECEC I u ? 5V
VMCU S023-6
Footprint
S023
Footprint
S028
Footprint

Mo MmmmmmmEm n = L X
e ) = -
: 9ﬁuuuuuuuuuuunucunuuncnuuuuunuumIﬁ LEDS
N°MppoooooonooEEoEOOOOOOOOCCOCOOOE| s ser
Bl° lmeooooooooo ooo Gc ook
°l |eooooooooo oon on =l
l//Booooooooocaon oooo ooo||™ i
3.3V LED . =fuununuuucuuuu oooo opom|| 805 Footprint
P :|lboooooruoooOoooOOO0O0OO0 goom
flooooooSOoO0pDODOOOCOOOOO a oooe

GO00ru00000000 0000000000000 0000000000000 0000000000000

Ground

53y N TN S TN 58 %0 e SOMigEe 2
. [ | Bk I §
A SISy SIS, round
...... TSSOP28
- Footprint
Hole Mount |
Area

Pin Headers
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19 Errata

19.1 DVK hardware errata
19.1.1 Port EO on EFM32 MCU board disconnected

Kit Revisions
Rev A
Description

Revision A kits are shipped with engineering samples of the EFM32. On MCU boards containing these
engineering samples, port EO on the EFM32 is disconnected. The MCU boards in question are shipped
with a sticker indicating that port EO is disconnected.

19.2 DVK firmware errata
19.2.1 VMCU regulator

Firmware Revisions
1.0.1
Description

Firmware version 1.0.1 contains an 12C driver that on some occasions hangs. When this happens, VMCU
freezes and can no longer be changed. The same issue may also result in wrong VMCU setting after
startup. A power cycle of the DVK fixes the problem. This errata is fixed in firmware version 1.1.1 or
newer.

19.2.2 Storing user configuration
Firmware Revisions
1.0.1
Description

Firmware version 1.0.1 contains an I2C driver that on some occasions hangs. When this happens, user
configuration may no longer be stored. A power cycle of the DVK fixes the problem. This errata is fixed
in firmware version 1.1.1 or newer.

19.2.3 Debug mode setting
Firmware Revisions
1.0.1
Description

When changing debug mode using the GUI, the actual configuration of the debug interface is not always
the same as the debug mode set by the GUI. An upgrade to firmware version 1.1.1 or newer fixes this
errata.

19.2.4 Serial Wire Output

Firmware Revisions
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1.0.1
Description

Enabling Serial Wire Output (SWO) would cause onboard firmware to fail. An upgrade to firmware version
1.1.1 or newer fixes this errata.

2010-11-12 - t0006_1.11 WWW.energymicro.com




EFM32 Development Kit

Board Function Page
Analog Interfaces 2
Sensors, SPI bus and I2C bus 3
User Interface 4
Display Interface 5
¥ Flash and SRAM 6
Board Control - Control MCU 7
Board Control - Buses 8
Board Control - Misc 9
Board Control - JTAG 10
control MCU 11
control MCU - BC Interface 12
B Debug Interface 13
Board Control - Level shift 14
EXP32 Assignments #1 15
EXP32 Assignments #2 16
EFM32 Board Connectors 17
EXP32 Board Connectors 18
Main Power Regulators 19
A EFM Power Regulators and AEM 20
Power monitoring 21

micro

Revision History

Rev. Description
A00 Initial release
A0l Minor update.

<Schematic Path>

TOP
Schematic Title
EFM32 Development Kit - Mainboard
Page Title
Designed: Approved: Title Page
Siz‘iNOBOM —— JNO Document number Revision
A3 BRD3200C A0l

<Cage Code>

Design Created Date:
Wednesday, December 03, 2008

Sheet Created Date
Saturday, March 21, 2009

Sheet Modified Date
Monday, June 28, 2010

Sheet
1 of 21



lf 5 TPO9 4 3 2 TP100 1
: C1 100P P2
2 [ 3 R2
3 1 —1 4 > ANALOG_SE_A (p 16,18)
4 N R1 390R TFEIOl TFEIOZ 5 o
5 o] [©
) R3 390R U1A BNC P3 TP103
BNC T1 — 8 R4 49R9 20P 2
GND T * 5 — . > ANALOG_DIFF_ N (p 16,18) El RO
VDIFFAMP . - AGND > ANALOG_SE_ B (p 16,18
2 c3 4 _SE_B (p16.18)
R7 390P 5
4
D R252 ?(?K 49R9 1 —1 > ANALOG_DIFF_P (p 16,18) e
OR R8 49R9
— R10 390R AD8132ARM
(p 16,18) ANALOG_DIFF_VCM ASND ca c6 c7 ASND ASND
NM 100N=— R11 R13 390R e
R12 24R9 — 20P 20P
10K L
|
N c8 100P N N
AGND AGND  AGND AGND AGND Si ng| e- Ended | nput s/ Qut put S AGND
R15 15K R17 15K
TP161 — —
| I | | I |
TP104 c9I |150P TP105 c1lolzzop
R19 | | TP106 | |
J2 R262 1K C16|10U 15K R20 27K U2A u3B
3 LINE_IN_RIGHT 2
VvV ¥ | —  +——1 1 - 14
R22 10R R23 7K5 | R24 7K5 TP107
4 R30 c12 1 — 8 10
e AN 1 AUDIO_IN_RIGHT (p 16,18) {p 16,18) AUDIO_OUT_RIGHT S e R— 3 b
AL 2 1K 680P R25 10R |?_| J1
1 c13 c15 3
C 3|y 10N w IN == — 51V
SJ1-3515 VLINE_IN AGND
AGND R16 47K TLV2473IDGQ MAX9724A R26 10R 4
AGND T—|: +—t — ' 213N
AGND GND |é| 1
R27 15K
R21 ci1 — TP108 SJ1-3515
47K 00N L
c1lslzzop c19 c20
R28 15K TFEIOQ | 10N 10N
— @) U3A
TP162 AND —1
C21 150P AO_SGND AO_SGND  AO_SGND
O— TP110 [ TP111 €22 p327k5 | R337K5 - - -
R263 C17 10U |]6_| R36 27K U2B ) p16,18) AUDIO_OUT_LEFT 3 I I 94— 1 Syt ouT>t
LINE_IN_LEFT 8
| - I S ) n 2Bl
K R35 R38 10R
R29 [ —c? ] 9 — . MAX9724A
" oop 2 > AUDIO_IN_LEFT (p 16,18)
c26 GND
7], 10N
AGND
AGND TLV2473IDGQ
- - - - AGND - - -
gline In Anmplifier & Filter Line Qut Driver & Filter
; c27 1U
Power Supply and Decoupli ng (|
[
usc
Llcip cin T(P)Z?’
VDIFFAMP
5 TP25 3ys3 (p9,16) AUDIO_OUT CONNECT 3 o
0 L s
u1B R42 10R [—— 5| 9
SHDN svss
3 ) — 1 2 R39 TP98 7
V+ LT 47K 5v L1 SGND
c32 | c33 | caa L3 BLM21B102S OR R40 T
6 7 ——100F——100 10U 1 2 — ) 12 4
V- NC= BLM21B102S L VDD ’f’c\;’ﬁg 2 —— c28
ADB132ARM GND c2o | c30 | ca1 1w
10U | 10N | 100P MAX9724A
AGND
3v3 : GND GND AO_SGND
<Schematic Path> -
VLINE_IN  Tp24 TP153 TOP
Q R41 L2 P
U2e o) 10R Schematic Title
5 [———— 10 — 1 2
A (p9,16) AUDIO_IN_CONNECT — ISHDN VDD 1 RS
: 1N BLM21B102S . .
6 | serion GND AO_SGND AO_SGND EFM32 Development Kit - Mainboard
R43
47K c3s | c36 | ca7 .
4 —— L Page Title
GND T 1008 T 108 T
1 100P | 10N | 10U
GND_HEAT Designed: Approved: Analog Interfaces
AGND TLV2473IDGQ JNO JNO isi
S SOM Do N Document number Revision
\/ A3 | <Cage Code> BRD3200C A0l
AGND Design Created Date: Sheet Created Date Sheet Modified Date Sheet
Wednesday, December 03, 2008 Saturday, March 21, 2009 Monday, June 28, 2010 2 of 21




5 4 - 3 2 1
U36A ADM3315E /o\ u43
(p16,18) IF_RS232 A TX X ; TINL D> TouTt ~i§ 22535 2 léTS S o R164 —— OR 3 ™
(p16,18) IF_RS232 A #RTS 2> g T_IN2 > 1 out2 P3g RS237 B TX ?& *—71© (p 16,18) IF_IRDA_TXD > LI 2| TXD
(p11,16,18) IF_RS232 B_TX T_IN3 > 1 outsp | *—=f—0 (p16,18) IF_IRDA_RXD 1 RXD
_ _ GND CH P B R165 OR »
3 ol ., (p9) IF_IRDA_SHUTDOWN D>—8 3 5y sp A
o
2 o A
10 15 RS232 A RX 6 R169 — 1
(p16,18) IF_RS232 A RX S 9 rRout1 < R_INL {57 RS235 A #CTS —1° 7 100K - 1 VCC2 (An)
(p16,18) IF_RS232_ A #CTS <& 9 RoOUT2 < RIN2 3 RS232 B RX ~ © R170 2
(p11,16,18) IF_RS232_B_RX d R_ouT3s <= R_IN3 \o’ GND 1R TPge O | cat
- - RX
D (P9) IF_RS232_SHUTDOWN —2 sp YCO_5747844_6 — 1 R171
GND e — 47R 7
s | p10 - &1 vLoG %
EN /o\ c161 c162 veel V4
g © 1ov 10ON c163 c164
(p11,16,18) CTRLMCU_RS232 B_TX 6 1o i 8
(p11,16,18) CTRLMCU_RS237_B_RX {&— w 415 GND
GND EN P B 10U T TlOON
3 o TFDU4300
Z Pl EE
o <~
%_O N GND
3 0o
~—~——_ GND
. S .
RS232 Physi cal Layer V55747804 6 | r DA transcei ver
3xa
3v3
u3s MMA7361L 3v3
6 2 ~
VDD XOUT SENSOR_ACCEL_XOUT (p 16,18)
c147 SENSOR_ACCEL_YOUT (p 16,18) R144 RP6
100N SENSOR_ACCEL_ZOUT (p 16,18) 10K PDV-P9003
5 3
VsSS YouT
(p 15,18) SENSOR_POTMETER ¢ (p 15,18) SENSOR_AMBIENT_LIGHT (&—¢
C GND GND
(p9) SENSOR ACCEL GSEL 10 | osEL zouT 2 . RP7 R145
10K
100K
(0 9,16) SENSOR_ACCEL_CONNECT §< 1; SLEEP o Cl4g | Ci49 | C150
(p9) SENSOR ACCEL_SELFTEST SELFTEST 0GDET ana T an3 T ana o
GND i i
R156 R157 V0LOO Pot t Ambi ent Li ght
100K 100K z2zzzz T N ot net er
ool GND GND GND
| i
GNDGND 3v3 3v3
3-axi s accel eroneter Ri59 R160 ava
4K7 4K7
R161 OR
3v3 —
(p 15,18) 12C_BUS_SDA
? (p 15.18) 12C_BUS scL $S 1 TP8s ?ggg
R255 1 1 1 R162 OR U41A U42A STDST75
5 1
p15,18) SPI_BUS_MOSI >>—|OR: (p9) SPI_BUS_MICROSD_#CS >>_RZ|%OR R273 R325 R326 R274 R275 6 Sgﬁ 2 Sgﬁ 0.
' o S s 47K 47K 47K 47K 47K
1 7
R254 NM NM 20 20
OR P16 2 6
— 1 3| AL 7 AL IS
315,18) SPI_BUS_MISO < 1 5 DAT?2 A2 WP A2
CD/DAT3
p15,18) SPI_BUS_SCLK »»— 7} i CMD GUND 24AA024 ~
R257 3v3 3v3 | 5 \C’EIE R168 GND
OR U45A  M25PX16 6 4K7
: 2 L e
D Q .
& paTL | 2C BuUs 2 Kbit EEPROM Tenperature Sensor
) SPI_BUS_FLASH_#CS S>—[1 )3 R173 €249
- - - 100K 100N microSD GND
R256 HoLD
OR 6l D |
R370
OR :
M SPI m croSD AV
GND
SPI Fl ash oo
<Schematic Path>
c153 | c152 | c151 TOP
U36B __ ADM3315E 100N | 100N | 100N I
6 20 Schematic Title
A > c1+ cL
5] C2+ c2 53 ) )
= ca 33 3v3 3v3 3v3 EFM32 Development Kit - Mainboard
? U45B M25PX16 U41B A U42B A
21 3 8 8 8 -
V- vce < » vce vce VDD Page Title
C156 C157 C158 C167
100 C159 4 ——100N 4 Cc168 4 C169 Designed: Approved: Sensors, SPI bus, 12C bus and 10
100N 100N 10U vss vss ——10N GND ——10N INO INO
23 GND vt 1 24AA024 STDS75 - Document number Revision
Size |BOM Doc No:
GND GND A3 | <Cage Code> BRD3200C A0l
o G:;ND G:;ND G:;ND Design Created Date: Sheet Created Date Sheet Modified Date Sheet
Wednesday, December 03, 2008 Saturday, March 21, 2009 Monday, June 28, 2010 3 of 21




Joystick

4
3v3
A
R179 JR17d JR177q JR17 JR17d JR18( JR181 JR182
10K | Jrok | Jrok [ Jrok | Jrok | Jrok | Jrox | Jrox
UIE_DIP[7..0]
7) UIF_DIP[7..0
(7 UFDIPI.0 & e
UIF_DIPO 1 [ Y 16
UIF_DIPL 2| o [[15
D UIF_DIP2 3| o |12
UIF_DIP3 4| 13
UIE_DIPZ 5 | e [12
UIF_DIP5 6 | mm— (1L
UIF_DIP6 7| ) [10
UIE_DIP? 8| w9
SW_DIP8_SMD
GND
3v3
Sw3 R187
R183 [Jr184 []R185 [ ]R186 100R
(0 8) UIF_PB[3.0] & UIF_PB[3..0] 100K | 100K | 100K | [100K 1 i 3 —
UIF_PBO J 2 N
UIE_PBL GND
UIF_PB2
C UIF_PB3 Sw4
R188
c170 | ci71 | ci72 | c173 1 i 3 100R
10N | 10N | 10N | 10N 4 [
GND
GND GND GND GND SwW5 R189
100R
1 i 8 —]
Ve
GND
SwW6 R190
(P8 AEM_PB < ava 1 i s 100R
]
Ve
GND
R219
100K SW10 R220
100R
P i 8 —]
C246 2 N
GND
10N
BUser pushbuttons oo
3¥3
R191 JR194 JR199 JR194 JR195
100K 100K 100K |100K] 100K
(p 8YIF_JOYSTICK[4.0] <
swz_~
UIF_JOYSTICK3 6
UIF_JOYSTICK4
UIF_JOYSTICKO
UIF_JOYSTICKL 2 5
UIF_JOYSTICK2
4
Cl174 C173 C176 C177 C178 ®
T 10n] 10N 10N] 10N] 10N R196
100R
A
GND GND

User LEDs

(p9) UIF_LEDS[4..0] ) e——

2 1
UIF_LEDSO R327 _ _ _
| I | ~
220R LED103 LED104 LED105 LED106
YELLOW YELLOW YELLOW YELLOW
™ ™ ™ ™
M 4 ™ 3 M 2 1
— — — —
UIF_LEDS1 R328 _ _ _
| I |
220R LED107 LED108 LED109 LED110
YELLOW YELLOW YELLOW YELLOW
™ ™ ™
™ 8 7 ™ 6
— — —
UIF_LEDS2 R329 _ _ _
| I | ~
220R LED114 LED113 LED112 LED111
YELLOW YELLOW YELLOW YELLOW
™ ™ ™ ™
~ 12 ~ 11 ~ 10 ™ 9
— — — —
UIF_LEDS3 R330 _ _ _
| I | ~
220R LED115 LED116 LED117 LED118
YELLOW YELLOW YELLOW YELLOW
™ ™ ™
™ 16 ™ 15 ~ 14 ™ 13
— — — —
UIF_LEDS4
I nputs| LED
zzz01 1
zz0z1 2
z0zz1 3
0zzz1 4
zzz10 5
zz01z 6
z0z1z 7
0zz1z 8
zz1z0 9
zz10z 10
z01zz 11
0z1zz 12
z1zz0 13
2120z 14
z10zz 15
01zzz 16
<Schematic Path>
Schematic Title
Page Title
Designed: Approved: User Interfaces
= ‘]NOBOM — JNO Document number Revision
1ze 0C NO:
A3 | <Cage Code> BRD3200C A01
Design Created Date: Sheet Created Date Sheet Modified Date Sheet
Wednesday, December 03, 2008 Saturday, March 21, 2009 Monday, June 28, 2010 4 of 21




5 4 3 2 1
3v3
A
3V3 3v3 DISP1
R115 R114  TP6OTP6ITP62TP63
47K 68K 00O O
(p7) DISPLAY #RESET
D (p7) DISPLAY DC g = | P2
(p7) DISPLAYZ#RD 95 > vai > vei
(p7) DISPLAYZ#WR 05 1 vel = ve
(p7) DISPLAY #CS T vss 7 vss
={ VDDIO ={ VDDIO
&1 vss &1 vss
TP13o  R27TORH 1 7 RESB - RESB
NM R268 OR 5] DC/SDC 5] DC/SDC
T NM 3369 OR 5 |E/RD 5 |E/RD
RIW / WR RIW / WR - -
(p9) DISPLAY_WSYNG i(; A i(; AN USMH-8252MD 320x240 TFT-LCD MODULE
51 scL > scL
15| sbo 15| sbo
14 \?\IDSIYNC 14 \?\IDSIYNC Bus Interface Table
DISPLAY DATALY 15 DISPLAY DATALY 15
(P7:8,9) DISPLAY_DATA[17.1] ), DISPLAY DATAL6 16 | D17 DISPLAY DATAL6 16 | D17
DISPLAY DATAILS5 17 | D16 DISPLAY DATAILS5 17 | D16 0010 | 16 bit 8080 style parallel
DISPLAY DATAL4 18 | D15 DISPLAY DATALZ 18 | D15
HEADER_2X10_1.27MM_SMD DISPLAY DATA13 19 | D14 DISPLAY DATA13 19 | D14 1011 | 9 bit 8080 style parallel
DISPLAY DATAL2 20 | D13 DISPLAY DATAL2 20 | D13
p17 DISPLAY DATALL 21 | D12 DISPLAY DATALL 21 | D12 1111 | 4-wire SPI
DISPLAY DATAL 1 [ "1 2 DISPLAY DATA? DISPLAY DATAL0 22 | D11 DISPLAY DATAL0 22 | D11
DISPLAY DATA3 3 | 2 =14 DISPLAY DATA4 DISPLAY DATA9 23 | D10 DISPLAY DATA9 23 | D10
DISPLAY DATA5 5 | = =16 DISPLAY DATAG DISPLAY DATA8 24 | D9 DISPLAY DATA8 24 | D9
DISPLAY DATA7 7 | 2 =18 DISPLAY DATAS DISPLAY DATA7 25 | D8 DISPLAY DATA7 25 | D8
DISPLAY DATA9 9 | 2 =1 10 DISPLAY DATAI0 DISPLAY DATAG 26 | D7 DISPLAY DATAG 26 | D7
DISPLAY DATAIT 11 | 2 =T 12 DISPLAY DATAI2 DISPLAY DATAS 27 | D6 DISPLAY DATAS 27 | D6
DISPLAY DATAI3 13 | & = 14 DISPLAY DATA14 DISPLAY DATA4 28 | D5 DISPLAY DATA4 28 | D5
C DISPLAY DATAI5 15 | o =T 16 DISPLAY DATA16 DISPLAY DATA3 29 | D4 DISPLAY DATA3 29 | D4
DISPLAY DATAI7 17 | g =118 DISPLAY DATA2 30 | D3 DISPLAY DATA2 30 | D3
19 20 DISPLAY DATAL 31 | D2 DISPLAY DATAL 31 | D2
il 32| D1 32| D1
33 | DO 33 | DO
NM 34| VSS 34| VSS
DISPLAY #RESET GND 35 | DOTCLK 35 | DOTCLK
DISPLAY_DC 36 | HSYNC 36 | HSYNC
37 VSYNC 37 VSYNC
38 | OF 38 | OF
VSS VSS
(0 9) DISPLAY_16BIT_#EN Zg PS0 4313 PS0
71| PsL 71| PsL
72| Ps2 77| Ps2
3v3 43| PS3 43 | PS8
24| vss 24| vss
25 | NC 25 | NC
Can be used TFT_LEDA  TFT_LEDK “as | NC 26| NC
a7 | NC TFT_LEDA TFT_LEDK a7 | NC
to sel ect >*—75 NC - - >*—75 NC
SPI node 79 Vss 28 1 vss
50 | 50 | K
A A
USMH_8252MD_320X240_RGB USMH_8252MD_320X240_RGB
NM
GND GND
B GND
R363 c292
100R 100N
NM NM
5V TP120 1FT 1 EDA
L11 A R276 3v3 3v3
— L5  10UH D1 330K ? For P7 ? For P15
1 2 o 288 2 IoF 1 —1 > DISPLAY_ASENSE  (p 21) < <
BLM41P600S c132 c133 c134 c113 c114 c115 i c131 c144 c129
— C250
10U - U 100N R278 [ =— 10U 100N 100N 10U 100N 100N
U3l NCP5006 27K 100N NM NM NM
D6 fx’
GND 5 1 GND GND : ?& ?&
VBAT vouT DFLZ24 <SChemat|C Path> GND GND
o TFT_LEDK R277 GND TOP
1K . .
4 3 R362 Schematic Title
(p7) DISPLAY_PWR_ENABLE 9 EN 2 FB [T 9 9 [ }—9—9+—>)DISPLAY_KSENSE (p 21)
o OR (L . .
R132 N c203[] Ri3L c251 EFM32 Development Kit - Mainboard
10K TP159 15R R279
100N 100N .
NM 100K Page Title
GND GND GND GND Designed: Approved: D|splay Interface
GND Siz‘lNOBOM Doc o, JNO Document number Revision
TFT- LCD power regul at or A3 | <Cage Code> BRD3200C AO1
Design Created Date: Sheet Created Date Sheet Modified Date Sheet
Wednesday, December 03, 2008 Saturday, March 21, 2009 Monday, June 28, 2010 5 of 21




D

C

B

A
C116
100N

5 3 2 1
(p8) FPGA_DATA[15..0] 2
(p8) FPGA_ADDR[23..0]
U25A
FPGA ADDRO E2 E3 FPGA DATAQ
FPGA _ADDRL D2 A0 DQO "f3 FPGA DATAL
FPGA_ADDR2 c2 1| Al DQ1 g7 FPGA DATA2
FPGA _ADDR3 A2} A2 DQ2 I"pz FPGA DATA3
FPGA _ADDR4 B2 | A3 DQ3 "5 FPGA DATA4
U52A FPGA_ADDRG D3| A4 DQ4 "5 FPGA DATAS
FPGA ADDRO A3 B6 FPGA DATAOQ FPGA_ADDRG c3 1| AS DQ5 g FPGA _DATAG
FPGA _ADDRL A4 AO 100 ¢35 FPGA DATAL FPGA_ADDRY A3 A6 DQ6 "Fp FPGA DATA7
FPGA _ADDR2 AG | Al 101 [~¢g FPGA DATA2 FPGA _ADDRS B6 || A7 DQ7 I'F3 FPGA DATA8
FPGA _ADDR3 B3 || A2 102 55 FPGA DATA3 FPGA_ADDRY AG | A8 DQ8 "G3 FPGA DATA9
FPGA _ADDR4 B4 | A3 103 I"Fg FPGA DATA4 FPGA_ADDRI0 C6 1| A9 DQ9 "F7 FPGA _DATALO
FPGA_ADDRG c3 1| A4 104 I"F5 FPGA DATAS FPGA ADDRLL D6 1| AL0 DQ10 "5z FPGA DATALL
FPGA_ADDRG cal| AS 105 |"F5 FPGA DATAG FPGA_ADDR12 B7 | ALL e = FPGA DATAL2
FPGA_ADDRY D4 | A6 106 &g FPGA DATA7 FPGA_ADDRL3 A7 AlL2 bQ12 "5g FPGA DATAL3
FPGA _ADDRS a2 A7 107 I"B1 FPGA DATA8 FPGA _ADDR14 c7 1 A3 DQ13 I"Fg FPGA DATAL4
FPGA_ADDRY H3 | A8 108 [ET FPGA DATA9 FPGA_ADDRI5 D7 Al4 DQl4 "57 FPGA DATAIS
FPGA_ADDRI0 Ha | 29 109 755 FPGA_DATAI0 FPGA_ADDR16 E7 | A15 DQ15_A1
FPGA_ADDRLL H5 1| AL0 1010 /53 FPGA DATALL FPGA_ADDRLY B3 || AL6
FPGA_ADDR12 G3 | ALL 1011 "F3 FPGA DATALZ FPGA_ADDR18 cal| ALY
FPGA_ADDR13 G4 | AL2 1012 I"F5 FPGA DATAL3 FPGA_ADDRI9 D5 1| Al8
FPGA _ADDR14 F3 | AL3 1013 I=F7 FPGA DATAL4 FPGA_ADDR20 D4 1| AL9
3v3 FPGA_ADDR15 Fa 1| Al4 1014 1757 FPGA DATAIS 3v3 FPGA_ADDR2L C5 1| A20
FPGA_ADDR16 E4 | ALS 1015 FPGA_ADDR22 Bg || A2L
FPGA_ADDRLY D3 1| A6 FPGA_ADDR23 cs 1| A22
FPGA_ADDR18 A1 1| ALY Fg 1| A23
R211 FPGA_ADDRI9 Gz | AL8 R117 Gg | A24
47K FPGA ADDR2L FPGA_ADDR20 He 1| A9 47K A25
T GND
A4 __
R212 OR NM al VBT
(p7) FPGA_SRAM_#LB % B2 LB F2 | __
(p7) FPGA_SRAM_#UB d us d ce
(07) FPGA_SRAM_#CS §< 85g cs FPGA #OE G294 op
(p11) CTRLMCU_SRAM_#7Z NC FPGA #WE  AS]
(p7) FPGA_#OE X 229 oF
(p7) FPGA_#WE d WE el
——————————d WP/ACC
N =
3v3 CY62147EV30LL-45BVXI SvTE
R213 B5,| —
K [] d RESET
R116 TP74
47K o S29GLxxx_FBGA
GND Wite Protect
(p7) FPGA_FLASH_#CS X
(p7) FPGAFLASH#BYTE 39
(p7) FPGA_FLASH #RESET R118
47K
NM
GND
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(p6) FPGA_FLASH_#CS <
(p6) FPGA_FLASH_#BYTE

(p6) FPGA_FLASH_#RESET

(p6) FPGA_SRAM_#CS

(p9,12) CTRLMCU_DATA[15..0]

(p17) FPGA #INT <&
(p11) CTRLMCU_FPGA _#INT

(p4) UIF_DIP[7..0] >

4 2
(p9,12) CTRLMCU_ADDR[21..16]  )mm
TP26 TP27 TP28 TP29
o O O O
CTRLMCU_ADDR20
TP30 TP31 TP33 CTRLMCU ADDRI9
o o CTRLMCU ADDR21 FPGA VCCO2
T ueC A
FPGA CFG_M P4 M9
FPgA gFg MflJ Na | |O_LOIN_2/MO VCCO_2 &7
FPGA CFG M2 (P5)|DISPLAY_PWR_ENABLE FPGA CEG W2 ;g :8:t8;§:§//gé078 ¥288:§ S?Z
2 T5 10_L02P_2/M2 VCCO_2
I0_LO3N_2/VS2
FPGA CFG RDAWR __Ra | |O_LOSN_
(p6) FPGA_SRAM_#LB (£ B oL oanCas0
(p6) FF%?’EE@X’%E S R5 | 10_L04P_2/VS1
P _ I0_LO5N_2
 e— T4 | 1O_LOSN_
> \ (P 6) FPGA_#WE CTRLMCU DATALL FPGA _CFG D6 T6 | |0-LOSP 2
CTRLMCU DATA12 FPGA CFG D7 T5 :8{82&%/’3?
(p5) DISPLAY_#RD §> Eg 10 LO7N 2
cTRLMCU DaTAdP D) DISPLAY_#WR FPGA CFG D4 Ng | |0_LO7P_2
CTRLMCU DATAL0 FPGA CFG D5 P7 :8{82&%/’3?’
(p5) DISPLAY #RESET <& ;3 10 LOON_2/GCLK13
(p5) DISPLAY_DC S =5 10_L09P _2/GCLK12
(p58,9) DISPLAY_DATA[17..1] G, DiSPLAY DATRD) DISPLAY_#CS T8 | |0 110N 2/GCLKIS
DISPLAY_DATALG g | I0_L10P_2/GCLK14
No| |0_L1IN_2/GCLK1
(p 10) FPGA_CLK §< To| I0_L11P_2/GCLKO
CTRLMCU_FSMC_CLK I0_L12N_2/GCLK3
DISPLAY DfPrAZ _FSMC_ R9 | IO_L12N_:
DISPLAY_DATA14 M10 | |O_L12P_2/GCLK2
DISPLAY DATAI3 N0 :8{12275
FPGA CFG #CS p10 | 10-L13P_
DISPLAY_DATA12 T10 | |O_L14N_2/MOSI/CSI_B
DISPLAY DATAIL RI1 | '0_L14P 2
DISPLAY_DATA10 T11 | |O_L15N_2/DOUT
DISPLAY_DATA9 Ni1 | |O_L15P_2/AWAKE
P11 | I0_L16N_2
CTRLMCU DATAS8 FPGA CFG D3 piz | |0 L16P 2
FPGA_CFG #INIT T12 | |O_L17N_2/D3
CTRLMCU_DATA6 FPGA CFe Bl Ris| IO_L17P 2/INIT_B
CTRLMCU DATA? FPGA CFG D? T13 | |O_L18N_2/D1
513 | 10_L18P_2/D2
CTRLMCU DATA3 Ni2 | /O_L19N_2
CTRLMCU DATA4 FPGA CFG CCLK R14 :8{;8&%@0_'(
TRLMCU DATA FPGA CFG D T14 | |O_L20N_
R199 IR : e I0_L20P_2/DO/DIN/MISO
4K7 UIF_DIP7 L7
UIF_DIP6 L8 :E%g
IF_DIP o IPL
e TTo-| IP2_2/VREF_2
UIE DIP3 w7 IP3_2/VREF 2
UIE DIP2 g | IP4_2/VREF 2
UIE DL i IP5_2/VREF_2
UIE DIPo Ne| IP6_2/VREF 2
IP7_2IVREF_2
XC35200A_4_FT256C_SWAPO

FPGA Init LED

FPGA_VCCO2

LED79
YELLOW

'’

R55
2K
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FPGA Configurati on Mde

FPGA CFG M2
FPGA CFG M1
FPGA CFG_MO
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TP34 TP35 TP36 TP37 TP38 TP39 TP40 TP4‘]].-

TP42 TP43 TP44 TP45

O O O O O O O O O O O FPGA_VCCO3
ueD
FPGA DATAO F3 D2
FPGA DATAL Ha3 | l0_Lo7P_3 VCCO_3 15
FPGA DATAZ2 b1 10_L12P_3/LHCLK2 VCCO_3 e—¢
FPGA DATA3 £5 | 10_L03P_3 VCCO_3 13
FPGA_DATA4 p1 | /O_LOSN_3 VCCO 3
FPGA DATAb B> | I0_L22N_3
FPGA DATA6 E5 | 10_L23N_3
FPGA DATAY H1] 10_L05P_3
FPGA DATAS f6 | |0_L1IN_3/LHCLK1
FPGA DATA9 75 10_L10P_3
D FPGA _DATAIL0 7 10_L12N_3/IRDY2/LHCLK3
FPGA DATALL 5 10_L17P_3
FPGA DATAL2 5| |0_L14P_3/LHCLK4
FPGA DATAL3 T 10_L18N_3
FPGA DATALA 5| I0_L16P_3/VREF_3
FPGA DATAILS T2 10_L16N_3
B) FPGA DATA[15.0]  ommmmmmmnel FPGA ADDRO H5 | |O_L19N_3
) FPGA_ADDR[23..0] 2 FPGA _ADDRL c2 | |O_L1ON_3
FPGA_ADDR2 c1 | '0_L01P_3
FPGA_ADDR3 F1 | /O_LOIN 3
FPGA_ADDR4 G3 | /0_L08P_3
FPGA_ADDR5 K4 | |0_Lo9P_3
FPGA_ADDR6 J1 | !0 L18P 3
FPGA ADDR7 E1 | I0_L14N_3/LHCLK5
FPGA_ADDRS M4 | /O_LO3N_3
FPGA_ADDR9 N1 | O_L24N_3
FPGA_ADDR10 KL | |O_L20N_3
FPGA ADDRLL K3 | I0_L15N_3/LHCLK?
FPGA ADDRL2 N3 | |O_L15P_3/TRDY2/LHCLK6
FPGA _ADDRI3 M3 | 10_L24P_3
FPGA_ADDR14 N2 | /O_L19P_3
FPGA _ADDRI5 M1 | '0_L22P_3
FPGA _ADDR16 D4 | /0_L20P_3
FPGA_ADDRLY Ha | 10_L02P_3
FPGA _ADDRI18 J6 | /O_LO9N_3
FPGA _ADDRI19 R1 | /O_L17N_3
FPGA_ADDR20 G1 | /0_L23P_3
FPGA ADDR21 G2 10_LO8N_3/VREF_3
FPGA ADDR22 G2 10_L11P_3/LHCLKO
C FPGA_ADDR23 D3 | /O_LO7N_3
I0_LO2N_3
UIF_PBO F4
UIF_PBL E2| IP_LO4N_3/VREF_3
UIF_PB2 G5 IP_L04P_3
UIF_PB3 G6 | IP_LOBN_3/VREF_3
UIF_JOYSTICKA 57 IP_LO6P_3
(p4) UIF_PB[3.0] P UIF_JOYSTICK3 7 IP_L13N_3
UIF_JOYSTICK2 we Y IP_L13P_3
UIF_JOYSTICKL Re Y IP_L2IN_3
UIF_JOYSTICKO 6 IH?@F’N
3/VREF_3
(p4) UIF_JOYSTICK[4..0] ) 5 P Loop s
(p4) AEM_PB)
XC35200A_4_FT256C_SWAPO
FPGA_VCCOO0
UBA A
DISPLAY DATAS8 c13 B5
DISPLAY DATA7 D13 | /O_LOIN O VCCO_0 [~Eg
BC BUS FPGA #OEL B14 | /O_LO1P_O VCCO_0 (&g
BC_BUS FPGA DIRL B15 | /O_LO2N_O VCCO_0 [B13
DISPLAY DATAG D11 | |0_L02P_O/VREF_0 VCCO_0
DISPLAY DATAS C12 :8{822%
BC_BUS_FPGA _#OEO Ag_| 10_LO3P |
(p5.7,9) DISPLAY_DATA[17..1] > BC EUS FPCA 4053 E10] 0_L12P_0/GCLK10
BC_BUS FPGA #OE3 Bg | |O_LO6N_O/VREF_0
BC _BUS FPGA DIRO C8 :8{%&78//8&&;1
14) B . QRS BC_BUS_FPGA DIR2 Co | |O_L11P
(p14) BC_BUS_FPGA #OE[3.0] < BC BUS FPGA DIR3 Dg | |O_L10P_O/GCLKE
BC BUS FPGA27 A9 | |O_L11IN_O/GCLK9
BC BUS FPGAZ26 D9 | |O_L1ON_O/GCLK?
BC BUS FPGAZ25 A10 | !O_LO9N_O/GCLKS
BC_BUS FPGA24 B10 | /O_LO8N 0
BC_BUS FPGA23 ALL :8{83&3
BC_BUS _FPGA22 ALz | 1O_LO7N |
(p14) BC_BUS_FPGA DIR[3.0] < BC_BUS TPGAZ2 A2 |5 06N 0
BC_BUS _FPGA20 A13 | 10_LOSP_O
BC_BUS FPGALQ Al4 | 10_L04N_0O
BC_BUS FPGALS c10 | /0_L04P 0
BC BUS FPGAL17 C11 10_L09P_0/GCLK4
BC_BUS FPGAL6 D10 | /0_LO7P_0
BC_BUS FPGAIS D5 | |O_LO6P_O
BC BUS FPGA14 Ca I0_L20N_0/PUDC_B
BC BUS FPGA13 C5 10_L20P_0/VREF_0
BC _BUS FPGA12 E7 | 'O_L17N_0
BC BUS FPGAL1 D7 10_L14N_O/VREF_0O
BC_BUS _FPGAIO Ce | /O_L16P_0
BC_BUS _FPGA9 C7 | |O_L16N_0
BC_BUS FPGAS B3 | /O_L13N_O
BC _BUS FPGA7 A3 | /O_L19N_O
BC_BUS _FPGA6 B4 | |O_L19P_0
BC_BUS _FPGA5 Az | /O_L18N_0
BC _BUS _FPGA4 A5 | 10_L18P_0
BC_BUS FPGA3 Fg | /O_L17P_0
BC _BUS FPGA2 B6 | 'O_L14P_0
BC _BUS FPGAL A6 | /O_L15N_O
BC_BUS_FPGAO A7 | /0_L15P_0
A (p 14) BC_BUS_FPGA[27..0] > BC_BUS CONNECT SP D6 :36%3[0
BOARD_REVISIONZ D12 |
BOARD_REVISIONL E6 :E%g
(p 14) BC_BUS_CONNECT_SPI > ggBARSE\?lI;\IgS’\:gNO E; P30
PCB_REVISIONL F10 P40
PCB_REVISIONO Eg | IP5.0
IP6_O/VREF_0
XC35200A_4_FT256C_SWAPO

PCB_REVISION2

FPGA_VCCOO
A

PCB_REVISION1

PCB_REVISIONO

PCB_REVISION[2:0]

GND

GND

FPGA_VCCOO0

R60
100K
NM

BOARD_REVISION2

BOARD_REVISION1

BOARD_REVISIONO

BOARD REVISION[2:0]
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D (p5,7,8) DISPLAY_DATA[17..1] <<
DISPLAY DATA4
DISPLAY_DATA3 FPGA_VCCO1
DISPLAY DATA2 usB A
DISPLAY_DATAL N14 E15
S pp1) ADC_DIN 2> Niz | '0_LOIN_1/LDC2 VCCO_1 15
pp1) ADC_#CS P15 | |0_L01P_1/HDC VCCO_1 378
(p4) UIF_LEDS[4.0] <X Riz | 10_L02N_1/LDCO VCCO_1 [Ni5
(03) SPI_BUS_FLASH_#CS ¢ ﬁig :8{85&1&?1 veeod
(p3) SPI_BUS_MICROSD_#CS Mia | |0_L03P_1/A0
Miz | IO_LOSN_1/VREF_1 R16
U TEDSZ Kiz | 10_L05P_1 SUSPEND
Mi6 | O_LO6P_ R78
3,16) SENSOR_ACCEL_CONNECT 10_LO7N_1/A5
UIF LEDs®? < '\ﬁg 10_LO7P_1/A4 10K
UF LEpsy (P 12) CTRLMCU_FSMC_#WAIT & L1610 L08N_1/A7
UIFTEDST 513 10_L08P_1/A6
S5 10_L10N_1/A9 oD
(p3) SENSOR_ACCEL_GSEL < iz | |0_L10P_1/A8
(p3) SENSOR_ACCEL_SELFTEST < Ri5 | |O_L1IN_1/RHCLK1
(p21) ADC_CLK < 316 '0_L11P_1/RHCLKO
(p 15) SENSOR_AMBIENT_LIGHT_CONNECT < K16 | |0_L12N_1/TRDYL/RHCLK3
(p 15) SENSOR_POTMETER_CONNECT < Hiz | 10_L12P_1/RHCLK2
(p16) IF_RS232_A_CONNECT < 372 10_L14N_1/RHCLK5
(p16) IF_RS232_B_CONNECT < 16| 10_L14P_1/RHCLK4
(p3) IF_RS232_SHUTDOWN < A5 10_L15N_1/RHCLK?
gp ig) ﬁiplliiuchsoggﬁﬁECT S Fi6 | |0_L15P_1/IRDY1I/RHCLKG
C p 15) IF_I2C_BUS_| S Gi6 | 'O_L16N_1/A11
(p16) IF_IRDA_CONNECT < G14 | 10_L16P_1/A10
(p3) IF_IRDA_SHUTDOWN < T3] 10_L17N_1/A13
(p16) ANALOG_SE_CONNECT < Fis | 10_L17P_1/A12
(p16) ANALOG_DIFF_CONNECT < Eic | |O_L18N_1/A15
(p 2,16) AUDIO_OUT_CONNECT < Fiz | 10_L18P_1/A14
(p 2,16) AUDIO_IN_CONNECT 13| IO_L19N_1/A17
(p5) DISPLAY_16BIT_#EN §> F13 | 1O_L19P_1/A16
(p17) FPGA_MCU_#RESET STRIVCU DATALE E1d :8{%8&%2}3
TRLMCU_DATA14 D15 | 1O_L20P_
(p7.12) CTRLMCU_DATA[15.0] ) e BIe| 10_L22N_1/A21
CTRLMCU DATA2 D14 | '0_L22P_1/A20
(p7,12) CTRLMCU_ADDR[21..16] E13 | |0_L23N_1/A23
CTRLMCU_DATAL ci5 :8{%2&?&%
CTRLMCU_DATAO C16 | |O_L24N_
10_L24P_1/A24
(p1%) CTRLMCU_FSMC_#OE % Eﬁ IP_LO4N_1/VREF_1
(p13) CTRLMCU_FSMC_#WE 2> L1 IP_L04P_1
1}) CTRLMCU_FSMC_#E1 IP_LO9N_1
CTRLMCU_ADDR16 (p1 — — < J10 '| 'P-LOIN_
STRIMGU ADDRLY ) CTRLMCU_FSMC_#ADV T IP_LO9P_1/VREF_1
CTRLMCU _ADDRI18 H10 :E{gg%
(p21) ADC_DOUT B> gi% IP_L2IN_1
(p5) DISPLAY_WSYNC IP_L21P_1/VREF_1
(p 15,18) SPI_BUS_#CS g EE IP_L25N_1 B
(p12) BC_BUS_CONNECT_EBI IP_L25P_1/VREF_1
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FKGA7VC CAUX

N
LEDSO
YELLOW
]
—
[] R68
D 470R
UBE
(p 12) FPGA_CFG DONE ¢ FFESAA gFFg EF%“'OEG T&g DONE GND ﬁie
(p12) FPGA_CFG_#PROG PROG_B GND [57
B2 GND I7BTT
™S GND
Al5 c3
« Bi6 | JCK GND [7C17
LED81 BL | IO GND I7F5
W Green ol SND [E12
N GND |55
GND
M F6
GND [
- GND [&715
GND [&7g
R71 GND |5
470R g“g J8
FPGA_VCCAUX K2
GND [7
E11 GND 7Kg
oND == VCCAUX GND [T3T
5| VCCAUX GND 75
VCCAUX GND et
M6 M5
FPGA_VCCINT yooRx anD | MB
G7 GND —p3
So| veainT GND [51z
Hg VCCINT GND &g
S5 VCCINT GND [R1p
5| VCCINT GND [
c %16 VCCINT GND 75
US6A 74LVC2G125DC VCCINT GND
XC35200A_4_FT256C_SWAPO
2 6
P4
2 [ 11 FHTRST A4
4] gml3 FH TDO - GND
6 | mml5 FATDI
8 | am |7 FHTNS U568 74LVC2G{125DC
0| gm]9 FHICK
5 3
2X5_2.54MM_TH
GND ~
] RP13 RP14
US7A H-P H-P SYCTRLMCU_JTAG_TMS (p 11)
(p12) TEST #RESET <K ) 5 - — s 51 — [E——<QCTRLMCULITAG_TCK (p 11)
- — = - — = CTRLMCU_JTAG_TDI (p 11)
— — {CTRLMCU_JTAG_TDO (p 11)
T 74Lve2G125DC 22R R294 OR
U57B 22R
NM
3 5
T 74LvC2G125DC
R336
C 1 > CTRLMCU_JTAG_#TRST (p 11)
B O0R
R295
47K
GND
3v3 Control MCU and FPGA cl ock
FPGA_VCCINT 3v3 3v3
FPGA_1V2 A A TP155
R72 1 R300 oA 3 Q@ PRs6
— US6C Us7C 33R R57 OUTPUT TS > CTRLMCU_CLK  (p 12)
Voo |8 Voo |8 u7B 100K
| ce2 | ce3 | cea | ces | co | c2 | ceo c262 | Voo |4 ) R0
10N | 10N | 100N | 100N | 100N 10U 47U 100N 73 73 OE :ZZR DPFPGACLK (P 7)
C40 24.00MHz
74LVC2G125DC 74LVC2G125DC 2 00N . § TP154
. GND <Schematic Path>
N y 24.00MHz
GND 7 J; TOP
GND GND GND Schematic Title
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5 4 3 2 1
(p 13) DEBUG_#TRST_OUT <
(p 13) DEBUG_TDI_OUT
(p 13) DEBUG_TMS_SWDIO_OUT g UL7A Control MCU
(p 13) DEBUG_TCK_SWCLK_OUT STRST OUT o2
(p 13) DEBUG_#TRST_IN X 0T F5| PAO/WKUP / USART2_CTS / ADC123_INO / TIM2_CH1_ETR / TIM5_CH1 / TIM8_ETR
(p 13) DEBUG_TDI_IN 2 S OG0T S5 PAL/ USART2_RTS / ADC123_IN1/ TIM5_CH2 / TIM2_CH2
(p 13) DEBUG_TMS_SWDIO_IN 2 TR OUT w5~ PA2/ USART2_TX/ ADC123_IN2 / TIM5_CH3 / TIM2_CH3
D (p 13) DEBUG_TCK_SWCLK_IN 2 RSTIN G3| PA3/USART2_RX / ADC123_IN3/ TIM5_CH4 / TIM2_CH4 PORT A
(p 13) DEBUG #RESET IN 2 TN F3-| PA4/ SPI1_NSS / DAC_OUTI / USART2_CK / ADC12_IN4
(p 13) DEBUG_TDO_SWO_IN TSN 53| PA5/ SPI1_SCK / DAC_OUT2 / ADC12_IN5
TN 75| PA6 / SPI1_MISO / TIME_BKIN / ADC12_IN6 / TIM3_CH1 [TIM1_BKIN]
R79 1K5 FRESET TN 5o PA7/ SPI1_MOSI / TIM8_CHIN / ADC12_IN7 / TIM3_CH2 [TIM1_CHIN]
Co| PA8/USARTL_CK/TIM1_CH1/MCO
— 11 D10 ] PA9/ USARTL_TX/ TIM1_CH2
R80 22R TDO_SWO_IN S10| PALO/ USARTL_RX/ TIM1_CH3
(p19)  USBDM > 3 510~| PALL/USARTL_CTS / CANRX / TIM1_CH4 / USBDM
(pP19)  USBDP 1 AT0-| PA12/USART1 _RTS / CANTX/ TIM1_ETR / USBDP
R81 22R 5| PAL3/JTMS-SWDIO
ces 8o Ag| PAL4/ JTCK-SWCLK
4 1 PA15 / JTDI
18P 18P 34
(p 13) DEBUG_EXT_VDD_TARGET X i PBO/ADC12_IN8 / TIM3_CH3 / TIM8_CH2N
(p 13) DEBUG_EXT_CABLE ATTACH &&—| PB1/ADC12_IN9 / TIM3_CH4 / TIM8_CH3N PORT B
o oo (p 20) AEM_VMCU_ENABLE & G5 | £E2/BOOT
A5 PB3/JTDO / TRACESWO /SPI3_SCK / 12S3_CK [TIM2_CH2 / SPI1_SCK]
&= PB4 /INTRST / SPI3_MISO [TIM3_CH2 / SPI1_MISO]
(p 13) DEBUG_BUF #OE %> 52— PB5/12C1_SMBAI / SPI3_MOSI /1253 _SD [TIM3_CH2 / SPI1_MOSI]
(p 13) DEBUG_TMS_SWDIO_#OE Ag—| PB6/12C1_SCL/ TIM4_CH1 [USART1_TX]
(p9) CTRLMCU_FSMC_#ADV & 57| PB7/12C1_SDA/ FSMC_NADV / TIM4_CH2 [USART1_RX]
(p 13) DEBUG #RESET  ¢& Az PB8/ TIM4_CH3/ SDIO_D4 [12C1_SCL / CANRX]
(p 1215.17.18) EEPROM_WP <& 5 PB9/ TIM4_CH4 / SDIO_D5 [12C1_SDA / CANTX
(p1217,18,20) CTRLMCU_I2C_SCL ¢& w7 PB10/12C2_SCL / USART3_TX [TIM2_CH3]|
(p1217,18.20) CTRLMCU_I2C_SDA ¢& K& PBLL/12C2_SDA / USART3_RX [TIM2_CH4]
(p12) CTRLMCU_SPI#CS {8 S5 PB12/ SPI2_NSS/12S2_WS / 12C2_SMBAI / USART3_CK / TIML_BKIN
(p12) CTRLMCU_SPI_SCK F6| PB13/SPI2_SCK/1252_CK / USART3_CTS / TIM1_CHIN
(p12) CTRLMCU_SPI_MISO Ga| PB14/SPI2_MISO / TIML_CH2N / USART3_RTS
c (p12) CTRLMCU_SPI_MOSI & PB15 / SPI2_MOSI / 1252_SD / TIM1_CH3N
F1
PCO/ADC123 IN10
F2 _
£5— PC1/ADC123_IN11 PORT C
5| PC2/ADC123_IN12
(p7) CTRLMCU_FPGA #INT &a| PC3/ADC123 IN13
Fi2-| PC4/ADC12_IN14
F1o| PC5/ADC12_IN15
(p13) DEBUG_DH SW_ENABLE (K E10-| PC6 /1252_MCK / TIM8_CH1 / SDIO_D6 [TIM3_CH1]
(p 13) DEBUG_MCU_SW_ENABLE =] PC7/12S3_MCK / TIM8_CH2 / SDIO_D7 [TIM3_CH2]
(p17,18) MCU_OSC_TEST E5-| PC8/ TIM&_CH3 / SDIO_DO [TIM3_CH3]
(p6) CTRLMCU_SRAM_#7Z 5| PCO/ TIM8_CH4 / SDIO_D1 [TIM3_CH4]
(p3,16,18) CTRLMCU_RS232 B TX 5| PC10/ UART4_TX/ SDIO_D2 [USART3_TX]
(p 316,18) CTRLMCU RS232 B_RX &5 PC11/UART4_RX /SDIO_D3 [USART3_RX]
A5~ PC12/ UARTS_TX / SDIO_CK [USART3_CK]
AT PC13/ TAMPER-RTC
51| PC14/0SC32_IN
PC15/0SC32_OUT
R296 OR ]
(p21) AEM_SENSE VOLTAGE 23:%: TP157
(p20,21) AEM_SENSE_CURRENT RANGE1 Short to QD to a3
R297 OR enter boot| oader
node during power up
R298 OR .
(p20,21) AEM_SENSE CURRENT RANGE2 1 I I\ Y 1
(p21) AEM_AUX_SENSE_VOLTAGE 1 ~p1
B R359 OR [ 111 ] 2k
—|Nfm <
N N N N
3vV3  3v3  3V3  3V3  3v3 - LED75! LED76! LED77! LED78
™ ™ ™ ™
3V3 M M M M
R82 []R83 [] R84 [] R85 []Rs6 _IVELLOW _|VELLOW _VELLOW _|VELLOW
P5 100K [ | 100K [ | 200K [ | 100K [ | 100K
%_ ! NM NM NM NM NM
e CTRLMCU _#TRST CTRLMCU_JTAG_#TRST (p 10)
N il CTRLMCU TDI &R CTRLMCU_JTAG_TDI (p 10)
8 | gml’ CTRLMCU TMS SWDIO R CTRLMCU JTAG_TMS (p 10)
0. 9 CTRLMCU_TCK_SWCLK % CTRIMCU ITAGTCK (p 10)
12 g g1l CTRLMCU RTCK A
ig am ig CTRLMCU TDO_SWD <§ CTRLMCU_JTAG_TDO (p 10) ]
N e CTRLMCU_DEBUG_#RESET (p 12) <Schematic Path>
20 | ggl19 TOP
2X10 2.54MM g
NM R8s RS9 R90 Re7 Schematic Title
A 100K 100K 100K 100K
NM NM NM NM .
EFM32 Development Kit
GNDGND GND GND Page Title
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5 4 3 2 1
3V3 3v3
3v3 3v3
R92 R93
s 1K 1K sTo
R e (p1117,18,20) CTRLMCU_I2C_SDA b
(p 11,17,18,20) CTRLMCU_[2C_SCL .
il
o . . s
LED124 LED123 3v3
BLUE YELLOW
D ] ~ U18A N
J-Link LED K K Debug LED Z SDA R94 R344 GND
- - scL
1 e
> A0
(p7.9) CTRLMCU_DATA[15.0] < U17B £ a1 ;
A2 wpP
CTRLMCU_DATA2 FSMC D2 D8 20AA02%
PDO/ OSC_IN / FSMC_D2 [CANRX]
TRLMCU DATA FSMC D E8 — _ N
< cy 3 SME D3 5| PD1/0SC_OUT / FSMC_D3 [CANTX] GND L EEPROM_WP (p11,15,17,18)
(p7) CTRLMCU_FSMC_CLK S | FSNC CIK G7 | PD2/TIM3_ETR / UART5_RX / SDIO_CMD
(p9) CTRLMCU_FSMC_#OE S | FSMC 7OE 57| PD3/FSMC_CLK [USART2_CTS]
(p9) CTRLMCU_FSMC_#WE | FSMC AWE B6 | PD4/ FSMC_NOE [USART2_RTS]
(p9) CTRLMCU_FSMC_#WAIT | FSMC AWAIT C6 | PD5/ FSMC_NWE [USART2_TX]
(p9) CTRLMCU_FSMC_#E1 ( | FaMC 7EL 56 | PD6 / FSMC_NWAIT [USART2_RX]
CTRLMCU DATA13 FaMC D15 Ko | PD7/FSMC_NEL/FSMC_NCE2 [USART2_CK]
CTRLMCU DATALZ FSMC D14 39 | PD8/FSMC_D13 [USART3_TX]
CTRLMCU DATALS FSMC DIS Ho | PD9/FSMC_D14 [USART3_RX] (p11) CTRLMCU_SPI_MISO
CTRLMCU ADDR16 S9| PD10/FSMC_D15 [USART3_CK] (p11) CTRLMCU_SPI_MOSI
STRIMCU ADDRLY Kio~| PD11/FSMC_A16 [USART3 CTS] (p11) CTRLMCU_SPI_#CS
CTRIMCU ADDRIS 10| PD12/FSMC_A17 [USART3_RTS / TIM4_CH1] (p11) CTRLMCU_SPI_SCK
CTRLMCU DATAO FSMC D0____Hio | PD13/FSMC_A18 [TIM4_CH2]
CTRLMCU DATAL FSMC DL Gio | PD14/FSMC DO [TIM4_CH3]
PD15/FSMC_D1 [TIM4_CH4]
D4
(p 10) FPGA_CFG_#PROG Q Ca | PEO/ TIM4_ETR / FSMC_NBLO U19A 33 3y
(p10) FPGA_CFG_DONE > A3—| PEL/FSMC_NBL1 2
CTRLMCU_ADDR19 FPGA CFG_#CS ~B3 | PE2/ TRACECK/FSMC_A23 b Q
C CTRLMCU_ADDR20 FPGA CFG RDAWR c3 Egiﬁgﬁggggﬁgmgﬁg 1l R95 R96
TRLMCU ADDR2L FPGA CFG #INIT D3 .
< cuY GA_CFG E3| PE5/ TRACED2 / FSMC_A21 . 100K 100K
PE6 / TRACED3 / FSMC_A22 HOLD
CTRLMCU_DATA4 FSMC D4 H5 . 6 D [73
CTRLMCU DATAS FSMC D5 35 | PE7/FSMC_D4 [TIM1_ETR] c W
(p79) CTRLMCU_ADDRI21..16] <=t CTRLMCU DATA6 FSMC D6 K5 | PE8/FSMC_D5 [TIM1_CHIN] M25PX16
CTRLMCU DATA?Y FSMC D7 G6 | PE9/FSMC_D6 [TIM1_CH1] R341
CTRLMCU_DATA8 FSMC D8 H6_| PE10/FSMC_D7 [TIM1_CH2N] 0R
CTRLMCU DATA9 FSMC_D9 36 | PE11/FSMC_D8 [TIM1_CHZ]
CTRLMCU DATALO FSMC D10 K6 | PE12/FSMC_D9 [TIM1_CH3N] NM
CTRLMCU DATALL FSMC D1l G7 | PE13/FSMC D10 [TIM1_CH3]
CTRLMCU DATAL2 FSMC D12 H7 | PE14/FSMC D11[TIM1_CH4]
PE15/ FSMC_D12 [TIM1_BKIN] oND
Control MCU
Control MCU Power & Bypass
u17¢
c1 B2
(p10) CTRLMCU_CLK > 51 OSC_IN VBAT
ADC_VREF < | OSC_OUT co1
(p11) CTRLMCU_DEBUG_#RESET »>—— 3v3 100N
TP50
R289 3v3 3v3
L10 R98 OR GND U198 U188 A
— 1R c96 3 8
3v3 |1 2 — _ ) K1 F7 vee vee
1 &1 VDDA VDD_1 g o0
R266 BLM21B102S R290 OR VSSA VDD_2 |5 3v3 4 ——I0N 4 c92
1 VDD_3 Vss VsS 1
OR C95 97 AN pp— VoD 4 LEA A i 0
(0 10) TEST #RESET 3> Zzgg 10U v HL| VREF Vbo 8 |2 C100 C101 C102 C103 M25PX16 24AA024
3v3 N Y& 10N C99 C105 N N
GND C263 F8 o p— . GND GND
LEDSS —— —|nc 100N T T T T 10U <Schematic Path>
RED 100N E7
sws R9 ~ xgg,; E6 TOP
10 v D5 2 [ E5 100N 100N 100N 100N P
BOOTO VSS_3 Schematic Title
1 3 GND E4 V4
- E1 VSS_4 &5
A - ._|:Tl NRST VSS 5 GND
2 4 _ . .
cos EFM32 Development Kit - Mainboard
N R331 Control MCU
100N -
GND OR Page Title
GND Designed: Approved: Control MCU - Board Control interface
GND
S ‘]NOBOM —— JNO Document number Revision
1ze 0C NO:
A3 | <Cage Code> BRD3200C A01
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av3 5 4 3 2 1
———————>>DEBUG_EXT_CABLE_ATTACH (p 11)
R101
10K VMCU VMCU VMCU VMCU
VTARGET
R204 [ ] R205 [] R206 [ ] R208
100K | | 100K | | 100K | | 47K
P6 NM NM NM NM R371 130R 74LVCA066 __ US3
1 DH_VTARGET — 2 1 RP3 U20A
Bl LI 1z — i
e 0E o R s st e i & oo mest our 1)
e o ~ — 182 1A2 DEBUG_TDI_OUT (p11)
D 8 | gm| 7 DHTMS SWDIO 10 _ 11 SW_TMS_SWDIO 3| — [® 5 24 1Dl
10 9 DH_TCK SWCLK 4z 4y SW_TCK_SWCLK 4 5 O 1A3 1773
V- :] 11 DH RTCK — 5] 1B4 1A4 7 < DEBUG_TCK_SWCLK_OUT (p 11)
12 | ® | 13 bA_TDO_SWO 13 VTARGET 100R <9 |1B5 1A5 775
uw 1E *—=— 1B6 1A6
16 15 DH_#RESET 5 1 38
uw 2E 1B7 1A7
18 | g li7 6 RP22 2 37 GND
20 19 SE (13 1 8 ~13| 188 1A8 35
a o 4E L= — 2B1 2A1 DEBUG_#TRST_IN (p 11)
1 2 |3 |4 |5 |6 |7 |8 R102 2| _ [ 14 1582 oaz |22 <$ DEBUG. TDI IN (p11)
2X10 2.54MM 47K 2 _ g ig 583 5A3 gg g DEBUG_TMS_SWDIO_IN (p 11)
GND AAAAAAARA R106 SW_TDO SWO - 19| 2B4 2A4 730 R DEBUG_TCK SWCLKIN (p 11)
2B5 2A5 DEBUG_TDO_SWO_IN (p11)
R104 R105 100K 38R 100R 20 | 585 one 22 < DEBUG_#RESET_IN (p 11)
100K 100K VESDO5A8A-HNH D8 741 VC4066 U54, 5V 22 27 - -
9 ) 1 — 55 2B7 2A7 5=
3112 —>— 1Y% R303 L1 2B8 2A8 [
v o g% —~ g 8 Reo 10E P28 < DEBUG_BUF_#OE (p11)
GNDGND N GND 10 11 R307 33R N OF 325 33 < _BUF_
47 —— 4y 20E
GND 4K7 GND 1
1DIR 5———
UBLA 24
13 2DIR
%E 5 DEBUG_HEADER_EN 6 2 74LVC161245
6 GND
3E 57—
4E 5V 74LVC2G125DC T GND
~
DEBUG_TMS_SWDIO_#0OE (p 11)
R306 3 5 >§ _TMS_ .
et Us1B DEBUG_TMS_SWDIO_OUT (p 11)
C VMCU VTARGET
MCU_SW_EN 3 5 U21B  74LVC2G125DC
(p17) MCUDBG_#TRST < , [ALVCa086  usen
(p 17) MCUDBG_TDI 17 —~— 1y < DEBUG_DH_SW_ENABLE (p11)
(p 17) MCUDBG_TMS_SWDIO g g 57 —~— oy g 74LVC2G125DC | ° GND
(p 17) MCUDBG_TCK SWCLK ¢& 3z —>— 3viog < DEBUG_MCU_SW_ENABLE (p11)
(p 17) MCUDBG_TDO_SWO 7 —~— v
(p 17) MCUDBG_#RESET > VTARGET
13
1E &5
2E 3
4315 7 R103
100K Uoia o { DEBUG #RESET (p11)
R107
SW_#RESET — 6 2
| I |
100R 74LVC2G125DC
GND
Power & Decoupling Ext. Debug Vol t age Measurenent
B VTARGET
VTARGET 3V3
o A 5V
R209 L16
O0R — 5V 126 VTARGET
U20B 125 BLM21B102S 1 2
7 — BLM21B102S —
Tz UEes 12 1 2 R100 100K
o 31 1 e °
42 | xggﬁ BLM21B102S > DEBUG_EXT_VDD_TARGET (p 11)
onp 12 u21c U53B U548 U58B us1C C106
10 8 14 14 14 8
GND 775 Vee I/ Cc247 vee C248 vee C264 vee vee 100K 10N
ci1 c112 g“g 21 C110 — — —
- = 28 4 p— 100N 7 100N 7 100N 7 c280 4
100N 100N OND T3z GND 100N GND GND GND - GND GND
e 2 74LVC2G125DC 74LVCA066 74LVC4066 74LVC4066 100N 74LVC2G125DC
Y
74LVC161245
GND N %
GND GND
GND :
<Schematic Path>
Schematic Title
A
Mbde DEBUG MCU_SW ENABLE | DEBUG DH_SW ENABLE | DEBUG BUF #OE| DH VTARGET | VTARGET EFM32 Development Kit - Mainboard
Debug Out 0 1 0 External vol tage| External voltage Page Title
MCU Debug 1 0 0 Di sconnect ed VMCU Designed: Approved: Debug Interface
N —
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5 4 2 av3
(p8) BC_BUS_FPGA DIR[3.0]
(p8) BC_BUS_FPGA_#OE[3.0]
R239
8) BC_BUS_FPGA[27..0
(p8) BC_BUS_| [27.0] < K8
(p 17,18) BC_BUS[27..0] {4
UsA TS3A475 RP15 ~
BC_BUSO 2 — 1 1[ __ |8 BC BUS ADO LEDS6 3v3
BC_BUS1 4| COM1 7™ NO1 I3 2| — [7_BC BUS ADIL W vELLOW
BC_BUS2 g | COM2 — ™ NO2 |75 3| — [6__BC BUS AD2 ™
BC_BUS3 10 ggm — “82 11 2| — [5_BCBUS AD3 U9A ~
2 [ o T 42 BC_BUS_FPGAO . R310
(017) BC_BUS_CONNECT EBI S>—4 BC_BUS_CONNECT EBI 12 N 33R g s T 212 gg 282 EESQ; - 1K8
61 IN2 6 | 183 1A3 73 BC_BUS _FPGA3 BC_BUS_CONNECT EBI 1,708 N
2 :“431 8 igg iﬁg a1 BC_BUS FPGA4 BC846AW
R265 o 18 e [0 BC_BUS FPGAb R240 N LED87
100K 1 38 BC_BUS FPGA6 10K W vELLOW
U10A TS3A475 RP16 12 | 1B7 1AT 737 BC_BUS FPGAY ™
BC_BUS4 2 = 1 1[ _ ]8 BCBUS AD4 13 | 1B8 1A8 735 BC_BUS FPGA8 ~
BC_BUS5 4 | COM1I — — NO1 I3 2| — [7_BCBUS ADS5 14 | 2B1 2Al 735 BC_BUS _FPGAO N .
BC_BUS6 g | COM2 — ™ NO2 |75 3| — [6_BC BUS AD6 16 | 282 2A2 733 BC_BUS FPGAILO GND -
GND BC_BUS7 10 | GOM3 ™ NOS 7 4| — [5 BC BUS ADY 17 | 283 2A3 735 BC_BUS FPGAIL
com4 NO4 19 ggg gﬁg 30 BC BUS FPGAL2 BC_BUS_CONNECT_SPI — 1. 07
13 33R 20 29 BC BUS FPGA13 — "NaBC846AW
57 IN1 22 | 286 2A8 757 BC BUS FPGAI14 R311 N
6 mg 23 gg; gﬁ; 26 BC_BUS FPGAIS 10K
2
IN4 1oE b8 BC_BUS FPGA #OEO
OE P55 BC_BUS_FPGA #OEL N
U11A TS3A475 RP17 20E 7 BC_BUS FPGA DIRO GND
BC_BUSS 2 — 1 1 __ |8 BC BUS AD8 1DIR €57 BC_BUS FPGA DIRL
BC_BUS9 4| COM1 ™ NO1 I3 2| — [7_BC BUS AD9 2DIR
BC_BUS10 9 ggmg — “85 8 3| — [(6__BC BUS ADID 74LVC16T245
BC_BUSIL 10| SOMS T N3 [ 2| — [5_BC BUS ADIL
13
3y g 33R
= IN2
12 :“431 VMCU 3v3
c A A
U13B
U12A TS3A475 RP18 veen Lo
BC_BUSI12 2 = 1 1[ __ 18  BC BUS ADI2 I |
BC_BUSI3 7 | com1 NO1 3 2 7 __BC BUS ADI3 VCCB 371
— — NO2 — VCCA *
BC_BUS14 9 ggmg e 3| — [6_BC BUS ADI4 Ve 421
BC_BUSI15 10| SOMS T N3 [ 2| — [5_BC BUS ADIS 13 oD
GND
13 15
L 33R 51| GND
= IN2 55| GND
IN3 GND
12 N3 gg o | c3 | cra | cr5 | cs
a5 | SN0 100N | 100N | 100N | 100N
U14A TS3A475 RP19 U13A
BC_BUSL 2 - 1 1 8 BC_BUS_ARDY 2 47 BC_BUS_FPGA27
Bg 38213 4| COM1 ™ NO1 I3 2| — [7 Bg 382 ALE 3 | 181 1A1 1776 Bg BLLJJS FPSAH raLvelorzes
BC_BUS18 g | GOM2 — ™ NO2 |75 3| — [6___BC BUS AWEN 5 | 182 1A2 724 BC_BUS FPGAI8 N N N
BC_BUSI19 10 ggmz _— Hgi i1 4| — [[5_BC BUS #REN 6 igi iﬁi 43 BC_BUS FPGAIO GND GND GND
3 a1 BC_BUS FPGA20
13 33R 9 | 1BS 1A5 775 BC_BUS FPGA21
5| IN1 11 | 1B6 1A6 38 BC_BUS FPGA22
6| IN2 12 | 1B7 1AT 737 BC_BUS FPGA23
12| N3 13 | 1B8 1A8 736 BC_BUS FPGA24
IN4 14 gg% gﬁ% 35 BC_BUS FPGA25
16 33 BC_BUS FPGA26
U15A TS3A475 RP20 17 | 283 2A3 735 BC_BUS FPGAIG
BC_BUS20 2 P 1 1[ 18 BC BUS #CSO 19 | 2B4 2A4 1735
BC_BUS21 4| COM1 ™ NO1 I3 2| — [7_BC BUS #CS1 20 | 285 2A5 59
BC_BUS22 g | GoM2 — ™ NO2 |75 3| — [6__BC BUS #CS2 22 | 286 26 57
B BC_BUS23 10 ggm — “82 11 2| — [5__BC BUS #CS3 GND |23 gg; gﬁ; 26 GND VXCU 3xs
u9B
13 33R |48 BC_BUS FPGA #OE2 7
5 IN1 10E P7s BC BUS FPGA #OE3 VCCB 1571
6 mg 12§|FE 1 BC BUS FPGA DIR2 ¥222 31
2y N R 2z BC_BUS FPGA DIR3 , veer a2 T
74LVC16T245 10 g“g
U16A TS3A475 RP21 15
BC_BUS24 2 P 1 1[__ 18 BCBUS SPI SCK 21 | GND
BC_BUS25 4 | COM1 — — NO1 I3 2| — [7_BC BUS SPI#CS 28 | GND
BC_BUS26 g | COM2 — — NO2 5 3| — [6_BC BUS SPI_MOSI 34 | GND cr7 | cis | cr9 | cso
BC_BUS27 10 | GOM3 — ™ NOS 7 4| — [5_BC BUS SPI MISO 39 | GND p— p—
coma NO4 5 g“g 100N | 100N | 100N | 100N
. BC_BUS_CONNECT_SPI 13 33R
17) BC_BUS_CONNECT_SPI Y = :H% AVCIETE
6
IN3
2 N N N
R312 IN4 GND GND GND
100K
GND <Schematic Path>
Schematic Title
A
3ve 3ve 3ve 3ve 3ve 3ve 3ve EFM32 Development Kit - Mainboard
U128 U14B u11B usB U168 U108 U158
14 14 14 14 14 14 14 .
V+ V+ V+ V+ V+ v+ Page Title
cs1 c82 c83 cs4 c85 Cc86 cs7 . .
R R R R R GND GND Designed: Approved: Board Control - EFM32 bus level shift & switch
100N 100N 100N 100N 100N 100N 100N INO INO
TS3A475 TS3A475 TS3A475 TS3A475 TS3A475 TS3A475 TS3A475 o Document number Revision
ize 0C NO:
{ i é A% 7 @ ?& A3 | <Cage Code> BRD3200C AO1
Design Created Date: Sheet Created Date Sheet Modified Date Sheet
GND GND GND GND GND GND GND
Wednesday, December 03, 2008 Saturday, March 21, 2009 Monday, June 28, 2010 14o0f 21



D

5 4 3 2 1
(p11,12,17,18,20) EFM32_A[83..0] D % < EXP32_A[83.0] (p11,12,17,18,20) (p7,9,11,12,13,14,16,17,18,20) EFM32_B[83..0] < EXP32_B[83.0] (p239,11,12,
3525 ﬁg; EEPROM_WP (p 11,12,17,18)
— CTRLMCU_I12C_SDA (p 11,12,17,18,20)
EXP32_A83 U44A TS3A475
CTRLMCU_12C_SCL (p 11,12,17,18,20)
EFM32_B64 2 1 EXP32_B64 EXP32_B64
cCOM1 — — NO1 SPI_BUS_SCLK (p 3,18)
EFM32 B65 4 . 3 EXP32_B65 EXP32_B65 S oI BUS 4GS (0918
EFM32_A40 EFM32_B66 g | com2 — NO2 =g EXP32_B66 EXP32_B66 i 1o (p9,18)
>MCU_OSC_TEST (p 11,17,18) S T COM3 —— NO3 =7 A A SPI_BUS_MOSI (p 3,18)
. : COM4 — — NO4 < SPI_BUS_MISO (p 3,18)
A Pins O -> 83 13
(p9) SPI_BUS_CONNECT = IN1
= IN2
R174 12 :“431
100K
EXP32_B[83..0] (p2,3,9,11,12,14,16,17,18,20
(p 14,17,18) BC_BUS[27..0] >y e _B[83..0] (p ) UA0A TS3A475
EFM32 B68 2 = 1 EXP32_B68 EXP32_B68
BC_BUSO EXP32 B16 GND EFEM32 B69 4 | COM1 — — NO1 I3 EXP32 _B69 EXP32_B69 < :g%gggégf (p§,1188)
BC BUSL EXP32 B17 EFM32_B70 g | com2 _— NO2 =g EXP32_B70 EXP32_B70 SO (p 3.18)
BC_BUS2 EXP32_B18 EFM32 B71 10 | GOM3 — ™ NOS 7 EXP32 B71 EXP32 B71 )2 gg“ggg—iagnﬁfﬁéﬂ%m)
BC BUS3 EXP32 B19 com4 NO4 = - (G
(p9) IF_I2C_BUS_CONNECT > - lg INL
L5) N2
gg 282‘5‘ 3525 520 (p9) SENSOR POTMETER CONNECT §< 12 IN3
ORI SR (p9) SENSOR_AMBIENT LIGHT CONNECT ING
BC_BUS7 EXP32 B23
R345 [ ] R346 [ | R166
BC_BUSS EXP32_B24 100K [ | 100K [ | 100K
BC_BUS9 EXP32 B25
BC_BUSI0 EXP32_B26
BC_BUSLL EXP32 B27
(p 14,17) BC_BUS_CONNECT EBI EFMS2 B72 GND  GND  GND
BC_BUS12 EXP32 _B28 6 1417) BC_RUS CONNECT 5Al <2 EFM32 B73
BC_BUSI3 EXP32_B29 p 14, 0 1517) FICUDBG, #TRST EFEM32 B74
BC_BUS14 EXP32_B30 ( 02 17} MCUDBG. FRESET §< EFM32 B75
BC_BUSI15 EXP32_B31 pLs, &
EFM32 B76
BC_BUS16 EXP32_B32 (©1317) (&éﬁéQG MrCcLéDS\C/\;/’cTSJ ( EEM32 B77 TP156
BC_BUSLY EXP32 B33 (p 1317) MGUDBG_TMS, SWDID EFM32 B78
BC_BUSI8 EXP32 B34 p( 1517 MOUDED, TDO, SWO < EFM32 B79
BC_BUSI19 EXP32 B35 p 13, _ThO_ EXP32_BSL
EFM32_B8O EFM32 B82 EXP32_B82 < EEPROM WP (p11,12,17,18)
BC BUS20 Expar B36 (p9,17) FPGA MCU_#RESET §< e e >§ CTRLMCU_I12C_SDA (p 11,12,17,18,20) e < CTRLMCU_I2C_SDA" (p11.12,
D T Lt (p 7.17) FPGA #INT CTRLMCU_12C_SCL (p 11,12,17,18,20) CTRLMCU_12C_SCL (p 11,12,
BC_BUS22 EXP32_B38
BC_BUSZ23 EXP32_B39
- H - >
BC_BUS24 EXP32_B40 B: Pins 64 83
BC_BUSZ25 EXP32_BAL
BC_BUS26 EXP32_B42
BC_BUS27 EXP32_B43
(p7,9,11,12,13,14,16,17,18,20) EFM32_B[83..0] p—(  EXP32_B[83..0] (p2,3,9,11,12,14,16,17,18,20)
(p 14,17,18) BC_BUS[27..0] ) (. EFM32_B[83..0] (p 7,9,11,12,13,14,16,17,18,20) EFM32 BO EXP32 BO
EFM32 BL EXP32 BL
BC_BUSO EFM32_B16 EFM32 B2 EXP32 B2
BC_BUSL EFM32 B17 EFM32 B3 EXP32 B3
BC_BUS2 EFM32 B18
BC_BUS3 EFM32_B19 EFM32 B4 EXP32 B4
EFM32 B5 EXP32_B5
EFM32 B6 EXP32_B6
BC_BUS4 EFM32_B20 EFM32 BY EXP32 BY
BC_BUS5 EFM32 B2L
BC_BUS6 EFM32_B22 EFM32 B8 EXP32_B8
BC_BUS7 EFM32_B23 EFM32 B9 EXP32 B9
EFM32 B10 EXP32_B10
BC_BUSS EFM32_B24 EFEM32 B1L EXP32 BLL
BC_BUS9 EFM32 B25
BC_BUSI0 EFM32_B26 EFM32 B12 EXP32 B12
BC BUSLL EFM32 B27 EFM32 B13 EXP32 B13
EFM32 B14 EXP32 B14
BC_BUS12 EFM32_B28 EFM32 B15 EXP32 B15
BC_BUSI3 EFM32 B29 . ; RS
BC_BUS14 EFM32_B30 B: Pins O 15
BC_BUSI5 EFM32 B3L
BC_BUS16 EFM32 B32
BC_BUSLY EFM32 B33
BC_BUSIS EFM32 B34 3v6
BC_BUSI19 EFM32 B35 U44B 3v6
14 U408
BC_BUS20 EFM32_B36 v+ 14
BC_BUSZ2L EFM32 B37 C166 v+
BC_BUS22 EFM32_B38 ——100N 7 C165
BC_BUSZ23 EFM32_B39 GND ——100N oo L2
TS3A4T5
BC_BUS25 EFM32_B40 (©9) SPI_BUS_CONNECT TS3A4T5
gg Egggg Emgg 2 (09) IF_2C_BUS_CONNECT g
) ) ) NS R (p9) SENSOR_POTMETER_CONNECT G:;ND
B: Pins 16 -> 43 (p9) SENSOR_AMBIENT_LIGHT_CONNECT . G:;ND
<Schematic Path>
R244 [] R245 [] R250 [] R249 TOP
2K 2K 2K 2K
Schematic Title
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5 4 3 2 1
{ EXP32_B[83.0] (p2,39,11,12,14,15,17,18,20)
(p7,9,11,12,13,14,15,17,18,20) EFM32_B[83.0]
U4A TS3A475
Eriis s i com —— ot |3 EXPor b1 EXPor b1 < ANALOG_SE A (p2,18)
— ANALOG_SE B (p 2,18)
com2 NO2 _SE B (p
EFM32_B46 9 Coms - NO3 8 EXP32_B46 EXP32_B46 R ANALOG DIFE N (p 2,18)
EEM32 B47 10| SOM3 N3 T EXP32 B47 EXP32 B47 0 ANALOG DIFF P (p218)
13
2 INL
D (P9) ANALOG_SE_CONNECT _ 9> Z IN2
(p9) ANALOG DIFF_CONNECT - +— IN3
L 12
R45 R46 USA TS3A475
100K 100K EFM32_B48 2 1 EXP32_B48 EXP32_B48
EEM32 B49 2| comr — — No1 3 SCEPR SCER 22 AUDIO_OUT_RIGHT (p2.18)
EFM32 B50 9 | COM2 . Noz g EXP32_B50 EXP32_B50 ﬁgggjﬁugrc':ﬁﬁ (<p22i§f)’)
EFM32_B51 10 | COM3 NO3 777 EXP32_B51 EXP32_B51 )2 — pe
GNDGND coM4 — — NO4 AUDIO_IN_LEFT (p2,18)
13
1—5’ IN1
(p2,9) AUDIO_OUT_CONNECT 9> =) IN2
(p2,9) AUDIO_IN_CONNECT - - IN3
L 12y,
R47 R48 U35A TS3A475
-
com2 NO2 IF_RS232 A #CTS (p 3,18)
EFM32 B54 o | Cove S Noele EXP32 B54 EXP32 B54 2 IF RS232 A FRTS (b 3.18)
EFM32 B 10 11 EXP32 B EXP32 B = A .
NooNs 32 BSS coMa — — NO4 32 BS5 32 BS5 < IF RS232 A TX (p3,16)
13
= INL
= IN2
5N IN3
(p9) IF_RS232_A_CONNECT - ING
U39A TS3A475
R253 EFM32_B56 2 — 1 EXP32_B56 EXP32_B56
100K EFM32 B57 47| coml T NO1 I3 EXP32 B57 EXP32 B57 % SENSOR AGCELYOUT (b3
C EFM32_B58 g | com2 _— Noz g EXP32_B58 EXP32_B58 D - - P,
EFM32_B59 10 | COM3 — NO3 7 EXP32_B59 EXP32_B59 S SENSOR_ACCEL_ZOUT  (p 3,18)
coOM4 — — NO4 ANALOG_DIFF_VCM (p 2,18)
13
o i
IN2
(p3,9) SENSOR_ACCEL_CONNECT - 12 IN3
IN4
R152
100K U37A TS3A475
couss o 2 o —— or |2 orz w0 N\ cox o 9 RO 110 0310
-
com2 NO2 < IF_IRDA_RXD (p3,18)
EFM32 B62 9 . 3 EXP32 B62 EXP32 B62 F RS2 TX 81118
GND EFM32_B63 10 | COM3 — NO3 7 EXP32_B63 EXP32_B63 — _B_TX (p3,11,18)
COM4 — — NO4 < IF_RS232_B_RX (p3,11,18)
13
1—5’ IN1
(p9) IF_IRDA_CONNECT = 3> =) IN2
(p9) IF_RS232_B_CONNECT * T2y e
IN4
R167 R151
100K 100K
i ->
VA B: Pins 44 63
(p9) IF_RS232_B_CONNECT
B (9 IF IRDA CONNECT <
(p3,9) SENSOR_ACCEL _CONNECT <S
(P9) IF_RS232 A CONNECT &S
(p2,9) AUDIO_IN_.CONNECT &S
(p2,9) AUDIO_OUT CONNECT &S
(P9) ANALOG DIFF_CONNECT <5
(p9) ANALOG SE CONNECT <S
R233 [] R234 [] R235 [] R236 [] R247 [] R246 [] R251 [] R248
2K 2K 2K 2K 2K 2K 2K 2K
N N N N N N N N
LED94 LED95 LED96 LED97 LED98 LED99 LED100 LED101
vELLow 7 veLLow N7 veLLow 7 YELLOW YELLOW vELLow 7 vELLow ¥ YELLOW
™ ™ ™ ™ ™ ™ ™
] ] ] ] ] ] ] ]
— — — — — — — —
GND GND GND GND GND GND GND GND
. H Single Ended Differential Audi o Qut Audio In RS232 A Accel eronet er I rDA RS232 B .
Switch Indicators <Schematic Path>
Power & Bypass Schematic Title
A . .
ave EFM32 Development Kit - Mainboard
3v6 3v6 3v6 [r_% OR  R238 usB 3v6
U398 U358 U378 2 1 14 OR  R237 U4B -
14 14 14 L v+ t,%l [ — 14 Page Title
V+ V+ V+ LI ? V+
L19 BLM21B102S c39 . .
c154 C155 C160 oo L7 L18 BLM21B102S c38 Designed: Approved: EXP32 signal assignments #2
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GND GND GND —I TS3A475 100N GND _I JINO JNO Document number Revision
TS3A4T5 TS3A4T5 TS3A4T5 ] TS3A475 Size |BOM Doc No:
i& ?& A3 | <Cage Code> BRD3200C A0l
Design Created Date: Sheet Created Date Sheet Modified Date Sheet
GND GND GND GND GND
Wednesday, December 03, 2008 Saturday, March 21, 2009 Monday, June 28, 2010 160f 21



5 4 2 1
(p7,9,11,12,13,14,15,16,18,20) EFM32_B[83.0] <
(p11,12,15,18,20) EFM32 A[83.0] 3V3 VMCU_M_CPU2 P13 VMCU_M_CPU2 3V3 3V3 VMCUM P14 VMCU_M 3V3
A A
2 1
1 3
N 6 5
81
] 10 9
EFM32_A0 EFM32_A40 EFM32_BO 12 11 EFM32_B40
EFM32_AL EFM32_A41 EFM32_B1 14 13 EFM32_B41
D EFM32 A2 EFM32_A42 EFM32_B2 16 15 EFM32_B42
EFM32_A3 EFM32_A43 EFM32_B3 18 17 EFM32_B43
20 19
EFM32 A4 EFM32_A44 EFM32 B4 ) 22 21 EFM32_B44
EFM32_Ab EFM32_A45 EFM32_B5 24 23 EFM32_B45
EFM32_A6 EFM32_A46 EFM32_B6 26 25 EFM32_B46
EFM32_A7 EFM32_A47 EFM32_B7 28 27 EFM32_B47
30 29
EFM32_A8 EFM32_A48 EFM32 B8 ) 32 31 EFM32_B48
EFM32_A9 EFM32_A49 EFM32_B9 34 33 EFM32_B49
EFM32_A10 EFM32_A50 EFM32_B10 36 35 EFM32_B50
EFM32_ALL EFM32_A51 EFM32_B11 38 37 EFM32_B51
40 39
EFM32 A12 EFM32_A52 EFM32 B12 ) 42 a1 EFM32_B52
EFM32_A13 EFM32_A53 EFM32_B13 44 43 EFM32_B53
EFM32_A14 EFM32_A54 EFM32_B14 46 45 EFM32_B54
EFM32_A15 EFM32_A55 EFM32_B15 48 47 EFM32_B55
50 49
EFM32_A16 EFM32_A56 EFM32_B16 ) 52 51 EFM32_B56
EFM32_AL7 EFM32_A57 EFM32_B17 54 53 EFM32_B57
EFM32_A18 EFM32_A58 EFM32_B18 56 55 EFM32_B58
EFM32_A19 EFM32_A59 EFM32_B19 58 57 EFM32_B59
60 59
EFM32_A20 EFM32_A60 EFM32_B20 ) 62 61 EFM32_B60
EFM32_A21 EFM32_A61 EFM32_B21 64 63 EFM32_B61
EFM32_A22 EFM32_A62 EFM32_B22 66 65 EFM32_B62
EFM32_A23 EFM32_A63 EFM32_B23 68 67 EFM32_B63
70 69
EFM32_A24 EFM32_A64 EFM32_B24 ) 72 71 EFM32_B64
C EFM32_A25 EFM32_A65 EFM32_B25 74 73 EFM32_B65
EFM32_A26 EFM32_A66 EFM32_B26 76 75 EFM32_B66
EFM32_A27 EFM32_A67 EFM32_B27 78 77 EFM32_B67
80 79
EFM32_A28 EFM32_A68 EFM32_B28 ) 82 81 EFM32_B68
EFM32_A29 EFM32_A69 EFM32_B29 84 83 EFM32_B69
EFM32_A30 EFM32_A70 EFM32_B30 86 85 EFM32_B70
EFM32_A31 EFM32_A71 EFM32_B31 88 87 EFM32 B71
90 89
EFM32_A32 EFM32 A72 EFM32_B32 ) 92 oL EFM32 B72
EFM32_A33 EFM32_A73 EFM32_B33 94 93 EFM32 _B73
EFM32_A34 EFM32_A74 EFM32 B34 96 95 EFM32 B74
EFM32_A35 EFM32_A75 EFM32_B35 98 97 EFM32 _B75
100 99
EFM32_A36 EFM32_A76 EFM32_B36 102 101 EFM32_B76
EFM32_A37 EFM32_A77 EFM32_B37 104 103 EFM32 B77
EFM32_A38 EFM32_A78 EFM32_B38 106 105 EFM32_B78
EFM32_A39 EFM32_A79 EFM32_B39 108 107 EFM32_B79
1110 109
EFM32_A80 EFM32_A82 EFM32_B80 112 111 EFM32_B82
EFM32_A81 EFM32_A83 EFM32_B81 114 113 EFM32_B83
1116 115
118 117
120 119
5V
5V
GND BTE_ 060 01 L D A GND GND BTE_ 060 01 L DA GND [r
B
VMCU_M VMCU_M_CPU2 VMCU_M 3v3 5V
i i ? ?
R364 c211 | c212 | c213 | c214 c215 | c216 | c217 | c218 | c219 Cc221 | c222 | c223 | c224 | c225
| I |
OR 100N | 100N | 100N | 10U 100N | 100N | 100N | 10U 10U 100N | 100N | 100N | 10U 10U
NM
GND GND GND
<Schematic Path>
Schematic Title
i i 3§3 5§ EFM32 Development Kit - Mainboard
c227 c228 | c229 | c230 c231 C232 | c233 | c234 | c235 c237 Cc238 | c239 | c240 | c241 Page Title
100N 100N | 100N | 10U 100N 100N | 100N | 10U 10U 100N 100N | 100N | 10U 10U Designed: Approved: EFM32 Board Connectors
NM
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)

EXP32_B[83.0] <

EXP32_A[83.0] <

VMCU_M_EXP2

5 4 2 1
3V3 VMCU_M_EXP2 P11 VMCU_M_EXP2  3V3 3V3 VMCU M P12 VMCU M  3V3
A A
2 1 2 1
Z 3 Z 3
6 5 6 5
8] 7 8]
| 70 9 | o 9 |
EXP32_AQ 7 11 EXP32_A40 EXP32 BO 7 11 EXP32 B4Q
EXP32 AL 14 13 EXP32 AdL EXP32 BL 14 13 EXP32 B4l
EXP32 A2 16 15 EXP32_Ad2 EXP32 B2 16 15 EXP32 B42
EXP32 A3 18 17 EXP32_A43 EXP32 B3 18 17 EXP32 B43
20 19 20 9|
EXP32 A4 22 21 EXP32_Ad4 EXP32 B4 22 21 EXP32 B44
EXP32 Ab 24 23 EXP32 A4S EXP32 B5 24 23 EXP32 B45
EXP32 A6 26 25 EXP32_Ad6 EXP32 B6 26 25 EXP32_B46
EXP32 A7 28 27 EXP32_Ad7 EXP32 BY 28 27 EXP32 B47
T 30 29 T 30 29|
EXP32 A8 32 31 EXP32 A48 EXP32 B8 32 31 EXP32 B48
EXP32 A9 34 33 EXP32_A49 EXP32 B9 34 33 EXP32 B49
EXP32_AL0 36 35 EXP32_A50 EXP32 B10 36 35 EXP32 B50
EXP32 ALL 38 37 EXP32 A5L EXP32 BLL 38 37 EXP32 B5L
T 0 39 T 0 39|
EXP32 A12 2 21 EXP32_A52 EXP32 B12 2 21 EXP32 B52
EXP32 AL3 44 23 EXP32 A53 EXP32 B13 24 23 EXP32 B53
EXP32 AL4 76 25 EXP32_A54 EXP32 B4 6 25 EXP32 B54
EXP32 ALS 28 47 EXP32_A55 EXP32 BI5 28 47 EXP32 B55
50 29 50 29 |
EXP32 A16 52 51 EXP32_A56 EXP32 B16 52 51 EXP32 B56
EXP32 ALY 54 53 EXP32 A57 EXP32 BL7 54 53 EXP32 B57
EXP32 AL8 56 55 EXP32 A58 EXP32 B18 56 55 EXP32 B58
EXP32_AL9 58 57 EXP32_A59 EXP32 B19 58 57 EXP32 B59
T &0 59 T &0 59 |
EXP32_A20 62 61 EXP32_A60 EXP32 B20 62 61 EXP32_B60
EXP32 A2L 64 63 EXP32 A6L EXP32 B2L 64 63 EXP32 B6L
EXP32 A22 66 65 EXP32_A62 EXP32 B22 66 65 EXP32 B62
EXP32 A23 68 67 EXP32 A63 EXP32 B23 68 67 EXP32 B63
T 7 69 T 70 69 |
EXP32 A24 72 71 EXP32_A64 EXP32 B24 72 71 EXP32 B64
EXP32 A25 74 73 EXP32_A65 EXP32 B25 74 73 EXP32 B65
EXP32 A26 76 75 EXP32_A66 EXP32 B26 76 75 EXP32_B66
EXP32 A27 78 77 EXP32_A67 EXP32 B27 78 77 EXP32 B67
T 80 79 T 80 79|
EXP32 A28 82 81 EXP32_A68 EXP32 B28 82 81 EXP32 B68
EXP32_A29 82 83 EXP32_A69 EXP32 B29 84 83 EXP32 B69
EXP32_A30 86 85 EXP32_A70 EXP32 B30 86 85 EXP32 B70
EXP32 A3L 88 87 EXP32 A7L EXP32 B3L 88 87 EXP32 B7L
T 89 T 89 |
EXP32 A32 92 o1 EXP32 A72 EXP32 B32 92 o1 EXP32 B72
EXP32 A33 94 93 EXP32 A73 EXP32 B33 94 93 EXP32 B73
EXP32 A34 9% 95 EXP32 A74 EXP32 B34 9% 95 EXP32 B74
EXP32 A35 98 97 EXP32 A75 EXP32 B35 98 97 EXP32 B75
T 100 99 T 100 99 |
EXP32 A36 102 101 EXP32 A76 EXP32 B36 102 101 EXP32 B76
EXP32 A37 104 103 EXP32 A77 EXP32 B37 104 103 EXP32 B77
EXP32 A38 106 105 EXP32 A78 EXP32 B38 106 105 EXP32 B78
EXP32_A39 108 107 EXP32_A79 EXP32 B39 108 107 EXP32 B79
T 110 109 T 110 109 |
EXP32_A80 112 111 EXP32_A82 EXP32 B8O 112 111 EXP32 B82
EXP32 A8L 114 113 EXP32_A83 EXP32 B8L 114 113 EXP32 B83
116 115 116 115
118 117 118 117
120 119 5V 120 119
5v
GND  BTE 060 0L LD A GND GND BTE 060 0L LD A GND [r
VM%UJ\A 3§3 5¥
c179 | ci180 | cis1 | cis2 c183 | c184 | ciss | c187 | ciss c189 | c190 | c1e1 | c192 | c1e3
VMCU_M VMCU_M_EXP2
T100NT100NT100N 10U T100NT100NT100NT1OU —|_10u T100NT100NT100NT1OU —|_10u
NM
& & &
GND GND GND
OR
<Schematic Path>
TOP
Schematic Title
3v3 5v . .
3 3 EFM32 Development Kit - Mainboard
c195 c196 | c197 | ci98 c199 c200 c202 | c203 c205 c206 | c207 | co08 | c209 Page Title
100N 100N | 100N | 10U 100N 100N 10U | 10U 100N 100N | 100N | 10U | 10U Designed: Approved: EXP32 Board Connectors
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5 4 3 2 1
J3
L4 5V
—/— D2 TP116 TP117 A
PS 1 1 2 1 SW9 L12  2UH2
3 4 1 D7  ZEN056V130 T
2 [ \IAN BLM41P600S 3 O\O 21 A 3 _ Fm_l
20 L~~~
12CWQO3FN
A4 RAPC722X 6A SPDT C244 L17 2UH2 C245 [] R216
GND 1K 5V
D [] R217 N 10U 10U
1K1 ~ sy TP121 FPGA_1Vv2
o GND GND GND LED119 115 R231
P8 TYCO 292304 GREEN 1 u73 L7 2UH2 1K
LED120 ~ 1 2 1 5 ~ . o !
GREEN ™ VIN Sw N
= > . BLM41P600S c297
6 5 Al R372 LED122
LT - cll OR 30P N GReeN
N NM C136 c137 >
% GND 2 GND B 4 j— _— M
< o o« = GND 10U 100N o
L6 C138 C139 -
—/— e — LM3674MF-1.2 R373
1 o~V 2 10U 100N OR
NM
N BLM41P600S
GND Y Y% Y% \/
> USBDM (0 11) GND GND  GND GND GND GND
> USBDP (p11) R133 OR
| I |
O O |
C TP164 TP165 c135
100N
/77 NM
GND
Power i nput FPGA core vol tage regul ator
TP119 TP163 3V3
5V
113
—/— U72 _ LM2830ZSD L8  2UH2
1 2 5 3 (p21)
7 VINA Sw » >
BLM41P600S R369 | VIND
100K R138 R230
6 D9 45K3 470R
EN N C140 cia1
c142 c143 2 1 i —
- = 7 | GND F8 22U 100N LED121 TP8L TP82 TP83 TP84 TP85 TP86 TP87
B 22U 100N DAP GREEN
R139 > 3v3 GND
10K M
M1 M2 M3 M4
—
N N N NV (p21)
GND GND GND GND GND GND  GND GND
GND GND GND GND GND GND GND
R258
OR
3. 3V power regul ator
FPGA_1V2 GND
R286
1K GND
3. 6V power regqul ator > FPGA_1V2 SENSE (p 21)
5V C259
A 3V6 R287
A 100K 100N
10 <Schematic Path>
A 5 TOP
IN ouUT1 GND ——
R366 ouT2 R367 Schematic Title
A C145 c294 10K SET 130K
f— — A — . .
10U 100N SHDN s ony L cae | cooe EFM32 Development Kit - Mainboard
‘ FAULT ' - —_1
3 .
3 oo 10U 100N Page Title
GND_HEAT  CC
LP3982ILD-ADJ R368 Designed: Approved: Power
N N 68K JNO JNO isi
GND GND S VITTSY Document number Revision
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5 4 3 2 1
SX TFEI15 TP167
5V 0
A TP113 TPLI2 \ycy R VMCU_S TP114 (@]
O] U27 gézo U26 5
5 1 R121 4 5 NC
* IN OUTL 7 ‘] I I ? ? COM A 1
R215 ouT2 R352 4R7 NO R122
10K seT kB OR R358  C121 c122 3 I— i o R214 OR VMCU_M 22K
c120 c123 ) — NM 1R8 10U 100N 5
1 1 SHDN v+ sT8
. -1 [ | o
100N 10U ____|s 2 —| 2
i . FAULT > VMCU_FB GND GND GND C260 . L JsTe
9 6 R353 c287 100N c124
D i GND_HEAT  cC uesA "~ O0R 718 TS5A3159A - T
G:;ND G:;ND oo LP3982ILD-ADJ o6 > NM 33N 100N .
33N 81, |7 4 L 1 \/ \/
'18—K' GND GND GND GND GND
GND U74A -4 100mA cal i bration switch
R123 ADS5245-100K MCP6001T 5V
56K —
| I |
R349
OR R128
GND 1K
5V
A TP158  VMCU
R354 © o
u60 OR LED102
° - 2 - — W GREEN
IN ouT 1 >
R218 ouT2 v
10K SET -
c284 c285 ) — R350 c281 | c288
1 SHDN 18K L e ©
p— . el —
10U 100N , AT UB9A 100N | 10U (011) AEM_VMCU_ENABLE 3 :—l’KggmeAw
GND 2 R242
9
b GND_HEAT  CC 8, —il— L ToK ~
\/ LP3982ILD-ADJ C289 \/ \/
GND GND GND R351 GND  GND )
C 3N L1 86K De2as 100K MCU power switch LED GND
MCU power regul ators GND  GND
VMCU_R VMCU_S
C194 TP137 VMCU_R VMCU_S
1N O] c210 TP138
vVCS || 1N O]
A R124 R291 | vVCS ||
J 1K8 U29 43R R377 R378 R125 R292 |
10K 10K U75A 4R7  U30 OR R379
c125 1] e 18 L — T 10K U758
00N 2 c126 1 8 5
L22 -INF -INS IN+ +
5V 00N 2| e
[r_% 6| rec c186 I 1 - R380
Z L ™ LA RVA N g VREG 10K %04 z ! ——>>AEM_SENSE_CURRENT_RANGE2
V+
BLM21B102S  R293 3 ;; 2| .
O0R 5|V 4 GND 3 i 6| - (p11,21)
——c261 CHINA ouTt TLV272 5|V 4 GND
10U V- (HEAT) — ] 9|V out TLV272
> AEM_SENSE_CURRENT_RANGE1 V- (HEAT)
R126 . —
N LTC6102CDD 12K R375 R376 (0 11.21) L
GND GND 1K OR piL N LTC6102CDD D10 R382
NM GND R127 BAT54S OR
B 10K NM R381
GND 1K
MCU power current sense o~ N NM
\ GND
5V GND GND
L23 5V L28 BLM21B102S
—1
R355
2 1 R35S —
L9 1 2 '&‘74
BLmM21B102s 1R T
U68B U748
c283 R357 c282 C298 C299 5
U [] 10K vbD p— 1U 100N vbD
4
4y scL 100N
=¥ SDA 3 5
ADO  GND GND
GND MCP6001T
AD5245-100K N N
(p11,12,17.18) CTRLMCU_I2C_SCL 3>—————9 GND GND .
(p11,12,17,18) CTRLMCU_I2C_SDA <Schematic Path>
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